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PicoVNA 6 and 8.5 GHz Vector Network Analyzers Safety

1 Safety

To prevent possible electrical shock, fire, personal injury, or damage to the product, carefully read this safety
information before attempting to install or use the product. In addition, follow all generally accepted safety
practices and procedures for working with and near electricity.

This instrument and accessories have been designed to meet the requirements of EN 61010-1 (Safety
Requirements for Electrical Equipment for Measurement, Control and Laboratory Use).

The following safety descriptions are found throughout this guide:
A WARNING identifies conditions or practices that could result in injury or death.

A CAUTION identifies conditions or practices that could result in damage to the product or equipment to which it
is connected.

WARNING

This product is for professional use by trained and qualified technicians only. To prevent injury or
death, use the product only as instructed and use only accessories that have been supplied or
recommended by Pico Technology. Protection provided by the product may be impaired if used in a
manner not specified by the manufacturer.

1.1 Symbols

These safety and electrical symbols may appear on the product or in this guide.

Symbol | Description

Earth (ground) terminal
This terminal can be used to make a measurement ground
_ connection. It is NOT a safety or protective earth.

Chassis terminal

Possibility of electric shock

instructions.

Do not dispose of this product as unsorted municipal waste.

CAUTION
A Appearance on the product indicates a need to read these safety
]

Maximum input/output ranges

WARNING
To prevent electric shock, do not attempt to measure or apply signal levels outside the specified
maxima below.

The table below indicates the maximum voltage of the outputs and the overvoltage protection range for each
input on the VNA and its calibration accessories. The overvoltage protection ranges are the maximum voltages
that can be applied without damaging the instrument or accessory.
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PicoVNA 6 and 8.5 GHz Vector Network Analyzers Safety
Instrument Connectors Maximum operating voltage (output | Overvoltage or overcurrent
or input) protection
Ports 1 and 2 +10 dBm (about 710 mV RMS) +20 dBm (about 2.2 V RMS)
Bias tees 1 and 2 +15VDC 250 mA
Trigger and reference in 16 V pk
Trigger and reference out OVto+5V Do not apply a voltage
Connector/Overvoltage Protection dBm -

VAN

> >

> DPe

[>E

WARNING
Signals exceeding the voltage limits in the table below are defined as "hazardous live" by EN 61010.

Signal voltage limits of EN61010
+60VDC 30V ACRMS + 42.4 V pk max.

WARNING
To prevent electric shock, take all necessary safety precautions when working on equipment where
hazardous live voltages may be present.

WARNING
To avoid equipment damage and possible injury, do not operate the instrument or an accessory
outside its rated supply voltages or environmental range.

CAUTION

Exceeding the overvoltage protection range on any connector can cause permanent damage to the
instrument and other connected equipment.

To prevent permanent damage, do not apply an input voltage to the trigger or reference output of the
VNA.

Grounding

WARNING
The instrument or SOLT-AUTO E-Cal module's ground connection through the USB cable is for
functional purposes only. The instrument does not have a protective safety ground.

WARNING

To prevent injury or death, or permanent damage to the instrument, never connect the ground of an
input or output (chassis) to any electrical power source. To prevent personal injury or death, use a
voltmeter to check that there is no significant AC or DC voltage between the instrument’s ground
and the point to which you intend to connect it.t it.

CAUTION
To prevent signal degradation caused by poor grounding, always use the high-quality USB cable
supplied with the instrument.

External connections

WARNING
To prevent injury or death, only use the power adaptor supplied with the instrument. This is approved
for the voltage and plug configuration in your country.
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Power supply options and ratings
Ext DC power supply
Model name USB connection
Voltage Current Total power
PicoVNA 106 121615V DC 185 A bk 2W
: USB 2.0. to BOAP
PicoVNA 108 Compatible with 25W
SOLT-AUTO E-Cal UsB 3.0 N/A
module

>

—
a

> > >

WARNING

Containment of radio frequencies

The instrument contains a swept or CW radio frequency signal source (300 kHz to 6.02 GHz at +6
dBm max. for the PicoVNA 106, 300 kHz to 8.50 GHz at +6 dBm max. for the PicoVNA 108) The
instrument and supplied accessories are designed to contain and not radiate (or be susceptible to)
radio frequencies that could interfere with the operation of other equipment or radio control and
communications. To prevent injury or death, connect only to appropriately specified connectors,
cables, accessories and test devices, and do not connect to an antenna except within approved test
facilities or under otherwise controlled conditions.

Environment

WARNING
This product is suitable for indoor or outdoor use, in dry locations only. The product's external mains
power supply is for indoor use only

WARNING
To prevent injury or death, do not use the VNA or an accessory in wet or damp conditions, or near
explosive gas or vapor.

CAUTION
To prevent damage, always use and store your VNA or accessory in appropriate environments.

Storage Operating
Temperature -20to+50°C +5to+40 °C
Humidity 20% to 80 %RH (non-condensing)
Altitude 2000 m
Pollution degree 2

>

CAUTION
Do not block the air vents at the back or underside of the instrument as overheating will cause
damage.

Do not insert any objects through the air vents as internal interference will cause damage.
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1.6

Care of the product

The product and accessories contain no user-serviceable parts. Repair, servicing and calibration require
specialized test equipment and must only be performed by Pico Technology or an approved service provider.
There may be a charge for these services unless covered by the Pico three-year warranty.

VAN
A

WARNING
To prevent injury or death, do not use the VNA or accessory if it appears to be damaged in any way,
and stop use immediately if you are concerned by any abnormal behavior.

CAUTION
Regularly inspect the instrument and all probes, connectors, cables and accessories before use for
signs of damage or contamination.

To prevent damage to the device or connected equipment, do not tamper with or disassemble the
instrument, case parts, connectors, or accessories.

When cleaning the product, use a soft cloth and a solution of mild soap or detergent in water, and do
not allow liquids to enter the casing of the instrument or accessory.

Take care to avoid mechanical stress or tight bend radii for all connected leads, including all coaxial
leads and connectors. Mishandling will cause deformation of sidewalls, and will degrade
performance. In particular, note that test port leads should not be formed to tighter than 5 cm (2”)
bend radius.

To prevent measurement errors and extend the useful life of test leads and accessory connectors,
ensure that liquid and particulate contaminants cannot enter. Always fit the dust caps provided and
use the correct torque when tightening. Pico recommends: 1 Nm (8.85 inch-Ib) for supplied and all
stainless steel connectors, or 0.452 Nm (4.0 inch-lb) when a brass or gold plated connector is
interfaced.
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2 Quick start guide

2.1 Installing the software

e Obtain the software from www.picotech.com/downloads:
o PicoVNA 2 (for the PicoVNA 106 model)

o PicoVNA 3 (for the PicoVNA 108 model)
e Connect the PicoVNA unit to the computer and wait while Windows automatically installs the driver.

In case of difficulties, refer to Software installation for more details.

Mixer measurements (PicoVNA 108 only)

Control of the PicoSource AS108 300 kHz to 8 GHz signal source is built into the PicoVNA software. If you wish to
carry out mixer measurements using other sources or sensors it is very likely that you will need to install the
Keysight® 10 Libraries Suite to support communication with external instruments through either the USB or GPIB
interfaces. Please see www .keysight.com for details.

2.2 Loading the calibration kit(s)

PicoVNA 106 or 108
Port 1 Port 2

PicoVNA 106 or 108
Port 1 Port 2

PicoVNA 106 or 108
Port 1 Port 2

Insertable
device
(test ports will connect directly

Non-insertable device
(test ports will connect directly together)

Non-insertable device
(test ports will not connect directly together)

together)
Male Female Male Male Female Female
connector l connector connector connector connector connector
Female cable. Male cable. Female cables. Male cables. Use
Use male cal kit. Use female cal kit. Use same male kit same female kit
for both ports. for both ports.
Insertable Device Male to Female or Female to Male. Non-Insertable Device Male to Male. Non-Insertable Device Female to Female.
Calibrate using fixed manual calibration standards: Calibrate using fixed manual calibration standards: Calibrate using fixed manual calibration standards:
SOLT-STD-F and SOLT-STD-M SOLT-STD-M SOLT-STD-F
or or or
SOLT-PREM-F and SOLT-PREM-M SOLT-PREM-M SOLT-PREM-F
or or or
Calibrate with PicoVNA 108 and automatic E-Cal Calibrate with PicoVNA 108 and automatic E-Cal Standard: ~ Calibrate with PicoVNA 108 and automatic E-Cal Standard:
Standard: SOLT-AUTO-M SOLT-AUTO-F
SOLT-AUTO-F
or
SOLT-AUTO-M

For manual SOLT calibration:

¢ Run the PicoVNA 2 or PicoVNA 3 software

¢ Inthe main menu, select Tools > Calibration kit

e Click Load P1 kit, select the data for your Port 1 kit and then click Apply
e Click Load P2 kit, select the data for your Port 2 kit and then click Apply

Select the calibration kit(s) required depending on the device to be tested.
Note: If testing a non-insertable DUT with, for example, female connectors, use a single female kit for ports 1 and
2.

For the PicoVNA 108 and an automated calibration:

e Run the PicoVNA 3 software
e Connect the E-Cal module to a spare USB port on the controlling PC
¢ Inthe main menuy, select Tools > Calibration kit
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¢ Click Electronic Cal kit

e Select the E-Cal module and Port Adaptor arrangement to suit the test ports

e Connect the E-Cal module, port adaptor and test ports to exactly match the selected configuration
¢ Click Find and load EasyCal data

e Upon completion select Exit

e Then click Apply in the Calibration Kit Parameters menu

2.3 Setting up calibration parameters

¢ Click Calibration to open the Calibration window:

Calibration
1. Set sweep St Swesp Frequency Cal Kit Loaded
_ _ - Po 1 Poat 2 Pt 2
parameters - I CoeritetS pan Fornat " ot
” - |FHDO0T-B5 |PrOCO0S -85
mils:  EHp & MHz T kHz
3. Select
St (37504 Massnamant |_— measurement
S 52 O 51«50 O | required
Fhop [pesa 987 Al

I
& Ireetable DUTIZ cal iz
i~ Morrrsetabls DUT M cal ki)

Ewerp AMETD) =| TOR ml  Morvieertabie DUT furknosn S cal
ot i Irvestable DUT [TRL / TRM) @—|

Siep [41504

Pico VNA 108 only

Lewel [cBm] 30
000X

Fisllach T 4. Perform required
. Time poirt fme] .,/ calibration steps
: O mode [~ ————— Lioad Isolsfion

2. Afte'r setting J:n-;u:ne.; | | (names and number
bardwndth, apply —_ Shot | Though | of required steps may
values i i
—e Aochs Er— differ, any sequence it

| Al wolstion, —_lrie | permi’ssible)

Cloze |

5. On completion,
apply calibration
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2.4

Setting up display parameters

See Display Setup for details on using the mouse to set values.

¢ Click Display in the main window to open the Display Set Up window:

Display Set Up

3. Select channel to set up Select

Yertical Axis
Urits
Reference
Ref Position

4. Check to show vertical

scale values on graphs Sensitivity

i

B -
1]

2
10

— O X

Parameter / Graph Type

Parameter [514 -
Graph LogMag -

Dizplay Channels

= CH1 " CH1.CH2

[ &
(" CH3,CH4 & ALl

Active Channel |2 -}_

1. Select
one-channel,
two-channel or
four-channel view

2. Select channel to
show in the Markers

N

panel
e Dizplay walues on graph v

-

Apply Close

Autozcale

5. Apply settings
before selecting
next channel

¢ When finished, click Start in the main window to begin measurements

2.5 Calibration tips

The bandwidth setting used during calibration largely determines the available dynamic range during the
measurement. The table below shows suggested bandwidth and power settings to use during calibration for
different types of measurement.

Measurement Calibration Calibration Calibration |Comments
bandwidth averaging power

Fastest speed 10 kHz None +0 dBm Set bandwidth to 140 kHz during
measurement

Best accuracy and 100 Hz None -3 dBm Leave bandwidth set to 100 Hz during

~100 dB dynamic range measurement

General use, fast speed, 1 kHz None +0 dBm Leave bandwidth set to 1 kHz during

~90 dB dynamic range measurement

Best dynamic range 10 Hz None +6 dBm Leave bandwidth set to 10 Hz during

measurement. Refer to “Calibration for best

dynamic range — minimizing the effect of
crosstalk”.

2.6 Running in demo mode

Demo mode allows you to explore the user interface software with no instrument connected.

e To enter demo mode, run the PicoVNA 2 or PicoVNA 3 software with no instrument connected.
e Fordemo mode, click Ignore in the dialog that appears.

The software will then offer you a selection of demonstration measurements.
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3 Description

The PicoVNA 106 and 108 are PC-driven vector network analyzers capable of direct measurement of forward and
reverse parameters. The main characteristics are as follows:

Model PicoVNA 106 PicoVNA 108
Operating frequency range 300 kHz to 6 GHz 300 kHz to 8.5 GHz
Dynamic range <118dB <124dB
Frequency resolution <10Hz <10Hz

A simplified block diagram of the instrument is shown below:

Test signal
F/R
o,

—

——3| ADCs Controller “
< RXA RXB m
3 3
s S
S RXC RXD S
O /, ,\ O
-- .() .................................... 0 -

Port 1 Port 2

Simplified block diagram of the PicoVNA units

The architecture is based on a four-receiver (Quad RX) arrangement using a bandwidth of up to 140 kHz. Couplers
A and B are wideband RF bridge components which provide the necessary directivity in both directions. Signal
detection is by means of analog-to-digital converters used to sample the IF signal. The sample data is processed
by the embedded controller to yield the | and Q components. The detection system operates with an IF of 1.3 MHz
and employs a patented circuit technique to yield fast speeds with very low trace noise.

The instrument's software runs on a personal computer and communication with the instrument is through the
USB interface. The software carries out the mathematical processing and allows the display of measured
parameters in many forms, including:

frequency domain

time domain

de-embedding utility

measuring output power at the 1 dB gain compression point

measuring AM to PM conversion

measuring frequency mixer characteristics (PicoVNA 108 only)

measuring phase and amplitude alignment of two external signal sources (PicoVNA 108 only)
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Description

P1CO  Vector Network Analyzer
b2 07

Technol/oygy/ PicoVNA 106 300 kHz — 6 GHz Quad RX

250 mA max. +20MR
Aﬁ VIDC max.

Test Bias-T Sweep Sweep Bias-T Test
I/O input indicator indicator input I/O
Port 1 Port 2

Front panel of the PicoVNA 106 (PicoVNA 108 is similar)

USB connection DC input On/off switch

10 MHz In

@I 12-15V DC
10 MHz Out

2
= <r ov0-L;
) ( ) ( ) (

10 MHz referencein/out  Chassis ground  Trigger in/out

Back panel of the PicoVNA 106 (PicoVNA 108 is similar)

pvug-5 Copyright © 2017-2022 Pico Technology Ltd

10



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Description

SOLT-STD-M/F and SOLT-PREM-M/F manual calibration standards

Indicator

USB port

Port A

SOLT-AUTO-M/F automatic (E-Cal) calibration standards

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 11



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Vector network analyzer basics

4 Vector network analyzer basics

4.1 Introduction

A vector network analyzer is used to measure the performance of circuits or networks such as ameplifiers, filters,
attenuators, cables and antennas. It does this by applying a test signal to the network to be tested, measuring the
reflected and transmitted signals and comparing them to the test signal. The vector network analyzer measures
both the magnitude and phase of these signals.

4.2 Structure of the VNA

The VNA consists of a tunable RF source, the output of which is split into two paths. The signal feeds to the
couplers are each measured by their respective reference receivers through power dividers. In the forward mode,
the test signal is passed through a directional coupler or directional bridge before being applied to the DUT. The
directional output of the coupler, which selects only signals reflected from the input of the DUT, is connected to
the Port1 receiver where the signal’s magnitude and phase are measured. The rest of the signal, the portion that
is not reflected from the input, passes through the DUT to the Port2 receiver where its magnitude and phase are
measured. The measurements at the Port1 and Port2 receivers are referenced to the measurements made by the
Ref1 and Ref2 receivers so that any variations due to the source are removed. The Ref1 and Ref2 receivers also
provide a reference for the measurement of phase.

Ref1 Port1
receiver receiver
A
Reference Directional
Forward signal coupler
<«—» DUT [«—»
Test
Reverse Reference Directional
. coupler
signal
y
Ref2 Port2
receiver receiver

Simplified vector network analyzer block diagram

In reverse mode, the test signal is applied to the output of the DUT, and the Port2 receiver is used to measure the
reflection from the output port of the DUT while the Port1 receiver measures the reverse transmission through the
DUT.

4.3 Measurement

Vector network analyzers have the capability to measure phase as well as magnitude. This is important for fully
characterizing a device or network either for verifying performance or for generating models for design and
simulation. Knowledge of the phase of the reflection coefficient is particularly important for matching systems
for maximum power transfer. For complex impedances the maximum power is transferred when the load
impedance is the complex conjugate of the source impedance (see figure).
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Source drives an unmatched Matching network, —jX,
load. Some signal is reflected. ensures all power is
transmitted to the load.

R —iX

R
/\_/ L /\_/ L

R R

Matching a load for maximum power transfer

Measurement of phase in resonators and other components is important in designing oscillators. In feedback
oscillators, oscillation occurs when the phase shift round the loop is a multiple of 360° and the gain is unity. It is
important that these loop conditions are met as close as possible to the center frequency of the resonant
element to ensure stable oscillation and good phase noise performance.

The ability to measure phase is also important for determining phase distortion in a network. Phase distortion can
be important in both analog and digital systems. In digital transmission systems, where the constellation depends
on both amplitude and phase, any distortion of phase can have serious effects on the errors detected.

4.4 S-parameters

The basic measurements made by the vector network analyzer are S (scattering) parameters. Other parameters
such as H, Y, T and Z parameters may all be deduced from the S-parameters if required. The reason for
measuring S-parameters is that they are made under conditions that are easy to produce at RF. Other parameters
require the measurement of currents and voltages, which is difficult at high frequencies. They may also require
open circuits or short circuits that can be difficult to achieve at high frequencies, and may also be damaging to
the device under test or may cause oscillation.

Forward S-parameters are determined by measuring the magnitude and phase of the incident, reflected and
transmitted signals with the output terminated with a load that is equal to the characteristic impedance of the test
system (see figure below).
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Vector network analyzer basics

Forward
_ Transmitted b,
a, Incident
> Z Joad
a,= 0
b, Reflected
1 DUT
L - Reflected b,
b, Transmitted
Z load <
Incident a
a=>0 2
Reverse
reflected b reflected b,
S“=L=—la2=0 Szzsz =|a, =0
incident  a, incident  a,
transmitted b transmitted b
521=—=—2a2=0 Slz=—=—1‘al=0
incident a, incident a,
S-parameter definitions
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The measured parameters are presented in a file similar to the one below. The format is as follows:
e Header lines: these start with a ! symbol and give general information such as time and date.
e Format line: this starts with a # symbol and gives information about the format of the data.

o First field gives the frequency units, in this case MHz

o Second field indicates the parameters measured, in this case S-parameters

o Third field indicates the format of the measurement, in this case MA meaning magnitude and angle. Others
formats are RI, meaning real and imaginary, and DB, meaning log magnitude and angle.

e Data lines. The number of columns of data depends on the parameters that have been measured.

o A 1-port measurement measures the reflected signal from the device under test and usually produces three
columns. If the format is MA (magnitude and angle), the first column is the measurement frequency, the
second is the magnitude of S, and the third is the angle of S,. If the format is RI, the second column is the
real part of S,, and the third column is the imaginary part of S,,.

o When a reflection and transmission measurement is made there are five columns of data. Column 1 is the
measurement frequency, columns 2 and 3 contain S,, magnitude and angle or real and imaginary data, and
columns 4 and 5 contain S,, magnitude and angle or real and imaginary data.

o If a full 2-port measurement is made, there will be nine columns of data. Column 1 contains frequency
information, columns 2and 3 S, data, 4and 5S,, data, 6 and 7 S,, data, and 8 and 9 S,,, data.

The PicoVNA 106 and 108 can generate full set of 2-port parameters but you can choose to export either 1-port
.s1p or full 2-port . s2p S-parameter files to suit most RF and microwave circuit simulators.

Part of a typical 2-port S-parameter file is shown below. The header shows that the frequency units are MHz, the
data format is Magnitude and Angle and the system impedance is 50 Q. Column 1 shows frequency, 2and 3 S,,,
4and5S,,,6and7S,,, and8and9S,,.

| 06/09/2005 15:47:34

| Ref Plane: ©.000 mm

# MHZ S MA R 50
!

3 0.60776 16.96 0.99337 -3.56 0.99324 -3.53 0.00768 12.97
17.985 0.01447 19.99 0.9892 -20.80 0.98985 -20.72 0.01519 15.23
32.97 0.01595 20.45 0.98614 -37.96 0.98657 -37.95 0.01704 6.40
47.955 0.081955 28.95 0.98309 -55.15 0.98337 -55.10 0.018 1.75
62.94 0.082775 24.98 0.98058 -72.29 0.98096 -72.29 0.0199 -6.07
77.925 0.063666 11.76 0.97874 -89.46 0.9803 -89.45 0.02169 -23.06
92.91 0.064159 -6.32 0.97748 -106.62 0©.9786 -106.62 0.01981 -48.43
107.895 0.06426 -24.79 0.97492 -123.77 ©.97579 -123.89 0.01424 -87.79
122.88 0.6396 -41.35 0.97265 -141.25 0.97269 -141.30 0.00997 -166.81
137.865 ©0.63451 -52.96 0.96988 -158.65 0.96994 -158.76 0.01877 113.15
152.85 0.03134 -56.07 0.96825 -176.27 ©0.96858 -176.28 0.03353 69.81
167.835 0.63451 -57.72 0.96686 166.10 0.96612 165.99 0.04901 34.83
182.82 0.04435 -67.59 0.9639 148.18 ©0.96361 148.21 0.06131 1.42
197.805 ©0.65636 -86.28 0.96186 130.15 0.96153 130.06 ©0.07102 -33.33
212.79 0.06878 -110.45 0.95978 111.82 ©.95996 111.90 0.07736 -69.57
227.775 ©.080835 -136.14 0.9557 93.50 0.9568 93.41 ©0.08303 -107.21
242.76 0.69099 -161.24 ©.95229 74.84 0.95274 74.89 0.08943 -144.34
257.745 ©.10183 175.34 0.94707 56.63 0.94755 55.95 ©0.09906 -179.63
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4.5 Displaying measurements

Input and output parameters, S,, and S,,, are often displayed on a polar plot or a Smith chart. The polar plot
shows the result in terms of the complex reflection coefficient, but impedance cannot be directly read off the

chart. The Smith chart maps the complex impedance plane onto a polar plot. All values of reactance and all
positive values of resistance, from 0 to oo, fall within the outer circle. This has the advantage that impedance

values can be read directly from the chart.
arcs of constant
reactance

=11 Reflection 2
R+jX _ centre of chart
(inductive) y A =Z,
@ (_.r/{
R-jX / real axis
(capacitive) fi
{
f
/
0Q 100
L ® L ] .

circles of constant
resistance

10.0000 MHz GO000.0000 kHz

The Smith chart

16
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4.6 Calibration and error correction

Before accurate measurements can be made, the network analyzer needs to be calibrated. In the calibration
process, well-defined standards are measured and the results of these measurements are used to correct for
imperfections in the hardware. The most common calibration method, SOLT (short, open, load, thru), uses four
known standards: a short circuit, an open circuit, a load matched to the system impedance, and a through line.
These standards are usually contained in a calibration kit and their characteristics are stored on the controlling
PC in a Cal Kit definition file. Analyzers such as the PicoVNA 106 and 108 that have a full S-parameter test set can
measure and correct all 12 systematic error terms.

R A
2. Leakage
A S
] ’o’
1. Directivity ,/ ot
, 4
’I ’I
2=t X —1  DUT
)
3. Reflection tracking (A/R) <
4. Transmission tracking (B/R) 5. Source mismatch 6. Load mismatch

Six key sources of errors in forward measurement.
Another six sources exist in the reverse measurement (not shown).
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4.7 Other measurements

S-parameters are the fundamental measurement performed by the network analyzer, but many other parameters
may be derived from these including H, Y and Z parameters.

4.7.1 Reflection parameters

The input reflection coefficient I' can be obtained directly from S, ;:

Vreflected

I'= =511 = pLo

Vincident
p is the magnitude of the reflection coefficient i.e. the magnitude of S, ;.
p=1S4l
Sometimes p is expressed in logarithmic terms as return loss:

return loss = —20 log(p)

VSWR can also be derived:

.ll”“

Py

VSWR = Cmax _11p

Emin 1- p

VSWR definition

4.7.2 Transmission parameters

Transmission coefficient T is defined as the transmitted voltage divided by the incident voltage. This is the same
as S,;.

_ Vtransmitted

Vincident

If T is less than 1, there is loss in the DUT, which is usually referred to as insertion loss and expressed in
decibels. A negative sign is included in the equation so that the insertion loss is quoted as a positive value:

Vtrans

insertion_loss(dB) = —201log = —20logt

Vincident

If T is greater than 1, the DUT has gain, which is also normally expressed in decibels:

Vtrans

insertion_gain(dB) = 20log = 20logt

incident
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4.7.3 Phase

The phase behavior of networks can be very important, especially in digital transmission systems. The raw phase
measurement is not always easy to interpret as it has a linear phase increment superimposed on it due to the
electrical length of the DUT. Using the reference plane function the electrical length of the DUT can be removed
leaving the residual phase characteristics of the device.

Raw Phase data Electrical Length function Residual Phase
-180
\ p )
\ \ A /
L ) /
Phase i\ B ¥ o )4
\ J / / N
\ \ ) /
+180 \ \\ P /
Trequerne | Frequemc Freqpency

Operation on phase data to yield underlying characteristics

4.7.4  Group delay

Another useful measurement of phase is group delay. Group delay is a measure of the time it takes a signal to
pass through a network versus frequency. It is calculated by differentiating the phase response of the device
with respect to frequency, i.e. the rate of change of phase with frequency:

del ¢
group_delay = —
dw

The linear portion of phase is converted to a constant value typically, though not always, representing the average
time for a signal to transit the device. Differences from the constant value represent deviations from linear phase.
Variations in group delay will cause phase distortion as a signal passes through the circuit.

When measuring group delay the aperture must be specified. Aperture is the frequency step size used in the
differentiation. A small aperture will give more resolution but the displayed trace will be noisy. A larger aperture
effectively averages the noise but reduces the resolution.
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4.7.5 Gain compression

The 1 dB gain compression point of amplifiers and other active devices can be measured using the power sweep.
The small signal gain of the amplifier is determined at low input power, then the power is increased and the point
at which the gain has fallen by 1 dB is noted.

Gain

\\t 1dB

Input Power

The 1 dB gain compression is often used to quote output power capability.

47.6 AMto PM conversion

Another parameter that can be measured with the VNA is AM to PM conversion. This is a form of signal distortion
where fluctuations in the amplitude of a signal produce corresponding fluctuations in the phase of the signal.
This type of distortion can have serious effects in digital modulation schemes where both amplitude and phase
accuracy are important. Errors in either phase or amplitude cause errors in the constellation diagram.

4.7.7  Time domain reflectometry (TDR)

Time domain reflectometry is a useful technique for measuring the impedance of transmission lines and for
determining the position of any discontinuities due to connectors or damage. The network analyzer can determine
the time domain response to a step input from a broad band frequency sweep at harmonically related
frequencies. An inverse Fourier Transform is performed on the reflected frequency data (S,,) to give the impulse

response in the time domain. The impulse response is then integrated to give the step response. Reflected
components of the step excitation show the type of discontinuity and the distance from the calibration plane.

A similar technique is used to derive a TDT (Time Domain Transmission) signal from the transmitted signal data
(S,7)- This can be used to measure the rise time of amplifiers, filters and other networks. The following provides

a more detailed treatment of TDR and TDT.
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4.7.7.1 Traditional TDR

The traditional TDR consists of a step source and sampling oscilloscope (see figure below). A step signal is

generated and applied to a load. Depending on the value of the load, some of the signal may be reflected back to

the source. The signals are measured in the time domain by the sampling scope. By measuring the ratio of the
input voltage to the reflected voltage, the impedance of the load can be determined. Also, by observing the

position in time when the reflections arrive, it is possible to determine the distance to impedance discontinuities.

Sampling Scope

O

— | Load

Step source

Traditional TDR setup

4.7.7.1.1 Example: shorted 50 ohm transmission line
d

< »
% Lot

TDR _G)J— j— )_4|—

Ei

0 time
Simplified representation of the response of a shorted line.
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For a transmission line with a short circuit (figure above) the incident signal sees the characteristic impedance of
the line so the scope measures Ei. The incident signal travels along the line to the short circuit where it is
reflected back 180° out of phase. This reflected wave travels back along the line canceling out the incident wave
until it is terminated by the impedance of the source. When the reflected signal reaches the scope the signal
measured by the scope goes to zero as the incident wave has been canceled by the reflection. The result
measured by the scope is a pulse of magnitude Ei and duration that corresponds to the time it takes the signal to
pass down the line to the short and back again. If the velocity of the signal is known, the length of the line can be
calculated:

where v is the velocity of the signal in the transmission line, t is the measured pulse width and d is the length of
the transmission line.

4.7.7.1.2 Example: open-circuited 50 ohm transmission line
d

v

A

TDR ) >

Ei

Fi

0 time

Simplified representation of the response of a open line

In the case of the open circuit transmission line (figure above) the reflected signal is in phase with the incident
signal, so the reflected signal combines with the incident signal to produce an output at the scope that is twice
the incident signal. Again, the distance d can be calculated if the velocity of the signal is known.

4.7.7.1.3 Example: resistively terminated 50 ohm transmission line

— Lr _ R-50
pP= Ei = R+50

R>50 R <50

" e

Ei Ei

time time

Simplified representation of the response of a resistively terminated line
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4.7.7.1.4 Reactive terminations and discontinuities

Reactive elements can also be determined by their response. Inductive terminations produce a positive pulse.
Capacitive terminations produce a negative pulse.

| > C—
— = — a J:-__

Ei Ei

time time
Simplified representation of the response of a reactively terminated line
Similarly, the position and type of discontinuity in a cable, due to connectors or damage, can be determined. A

positive pulse indicates a connector that is inductive or damage to a cable, such as a removal of part of the outer
screen. A negative-going pulse indicates a connector with too much capacitance or damage to the cable, such as

being crushed.
Ei Ei \/

time

time

Simplified representation of the response of a line discontinuity

4.7.7.2 Time domain from frequency domain

An alternative to traditional TDR is where the time domain response is determined from the frequency domain
using an Inverse Fast Fourier Transform (IFFT). Several methods are available for extracting time domain
information from the frequency domain. The main methods are lowpass and bandpass.

4.7.7.2.1 Lowpass method

The lowpass method can produce results that are similar to the traditional TDR measurements made with a time
domain reflectometer using a step signal, and can also compute the response to an impulse. It provides both
magnitude and phase information and gives the best time resolution. However, it requires that the circuit is DC-
coupled. This is the method supported by the PicoVNA 106 and 108.

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 23



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Vector network analyzer basics

The lowpass method uses an Inverse Fourier Transform to determine the impulse response in the time domain
from the reflection coefficient measured in the frequency domain. The DC component is extrapolated from the
low-frequency data to provide a phase reference. Alternatively, if the DC termination is known it can be entered
manually. Once the impulse response is computed, the step response may be determined from the time integral
of the impulse response. In the step response mode the trace is similar to that of a TDR, except that there is no
step at t = 0. When the time domain response is derived from the frequency information the value att = O is the
impedance of the transmission line or load immediately following the calibration plane. The value is referenced to
50 Q, the characteristic impedance of the system. For example, an open circuit would appear as a value of +1 unit
relative to the reference value and a short circuit would appear as a value of —1 unit relative to the reference value
(see example TDR plots above).

To facilitate the use of the Inverse Fourier Transform to compute the time domain response, the samples in the
frequency domain must be harmonically related and consist of 2" points. For this reason, the TDR facility in the
PicoVNA 106 and 108 makes available special 512, 1024, 2048 and 4096-frequency-point calibrations with a stop
frequency of up to 6000 MHz (PicoVNA 106) or 8500 MHz (PicoVNA 108). The resulting alias-free range is a
function of the number of frequency points (N) and the total frequency span. It is given by the expression:

R N-1
~ FreqSpan

So, the available ranges on the PicoVNA units are approximately as follows:

Model PicoVNA 106 PicoVNA 108
Ranges 100 ns, 171 ns, 341 ns, 683 ns 60 ns, 120 ns, 240 ns, 481 ns
Time resolution 98 ps 10 84 ps 58 ps

The transform returns twice the number of points of the calibration in the time domain. Therefore the above
ranges provide time resolutions approximately as shown.

4.7.7.2.2 Bandpass method

The bandpass method provides only magnitude information so it is not possible to distinguish between inductive
and capacitive reactances. Also, the time resolution is only half as good as in the lowpass mode. However, the
method can be used for circuits where there is no DC path and hence is suitable for AC-coupled circuits such as
bandpass filters. This method is not currently supported by the PicoVNA 106 and 108.

4.7.7.3 Windowing

The bandwidth of the network analyzer is limited by the frequency range, so the frequency domain data will be
truncated at the bandwidth of the analyzer. Also the analyzer gathers data at discrete frequencies. The result of
the sampled nature of the data and the truncation in the frequency domain is to produce a sin(x)/x response when
transformed to the time domain. This appears as ringing on both the displayed impulse response and the step
response. To overcome this problem, a technique known as windowing can be applied to the frequency domain
data before implementing the Inverse Fourier Transform.

The windowing function progressively reduces the data values to zero as the edge of the frequency band is
approached, thus minimizing the effect of the discontinuities. When the modified data is transformed, the ringing
is reduced or removed depending on the selected windowing function. However, the windowing function reduces
the bandwidth and so increases the width of the pulse in impulse response mode and slows the edge in step
response mode. A balance must be made between the width of the pulse, or speed of the edge, and the amount
of ringing to be able to determine closely spaced discontinuities. The PicoVNA 106 and 108 allow you to choose a
rectangular window (no bandwidth reduction), a Hanning window (raised cosine), or a Kaiser—Bessel window.
The order of the Kaiser—Bessel window is configurable.
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4.7.7.4 Aliasing

The sampled nature of the data means it is subject to the effects of aliasing. The result is repetition of time-
domain response at the effective sampling rate in the frequency domain. This limits the maximum time delay and
hence maximum cable length that can be observed. In the PicoVNA 106 this is 683 ns (approximately 138 m of
cable) and in the PicoVNA 108 it is 481 ns (approximately 97 m of cable).
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5 Getting started

Refer to the Quick Start Guide above for initial instructions, then return here for more detail.

9.1 Minimum requirements

A PC or laptop is required to operate the VNA. The recommended minimum requirements are stated in the
Specifications.

The performance of the software is influenced by the performance of the PC and video adaptor installed in it. It is

important that an adaptor with good graphics performance is used. As a general guide, it is recommended that an
adaptor with at least 64 MB of memory is used.

5.2 Software installation

Follow the Quick Start Guide to install the software from the disk or from www picotech.com. The installer will
copy the program and the USB driver to your computer. You need administrative privileges in order to run the
installer.

The installer creates a support directory at one of these locations:

e PicoVNA106:C:\User\Public\Documents\PicoVNA2
e PicoVNA108:C:\User\Public\Documents\PicoVNA3

This directory contains the following files:

e xxx-log.txt The status log file. ‘xxx” is the serial number

e DefCal.cal Default calibration data (last used calibration)
e UsersGuide.pdf This User's Guide

e Support\ Folder with data files to support the software

5.2.1 Typical error messages
On Windows 7 machines it is common to see the following error message:

Error l"" : "’“J

Ch\Windows\system32\stdole2.tlb

Unable to register the type library: RegisterTypelib failed; code
03002801 C.
Error accessing the OLE registry.

Click Retry to try again, Ignore to proceed anyway (not recommended),
or Abort to cancel installation.

[ Abort l | Retry | | Ignare

Itis safe to click Ignore to continue the installation.
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5.2.2  Mixer measurements (PicoVNA 108 only)

Control of the PicoSource AS108 300 kHz to 8 GHz signal source is built into the PicoVNA software. If you wish to
carry out mixer measurements using other sources or sensors it is very likely that you will need to install the
Keysight® 10 Libraries Suite to support communication with external instruments through either the USB or GPIB
interfaces. Please see www.keysight.com for details.
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9.3 Switching on the VNA

When the VNA is powered on, the front-panel channel activity indicators will flash to indicate that the controller
has started correctly.

5.4 Calibration kit parameters

The minimum requirements to carry out a 12-term calibration (full error correction) depend on the device to be
tested. For example, the most accurate calibration is for insertable devices, and this requires a total of six
standards: three of the four in each of the male and female cal standards.

An ‘insertable’ device is one that has connectors of different sexes at its ports. On the other hand, a calibration
for a non-insertable device can be carried out using only three standards by using the unknown thru calibration
method.

The calibration kits parameters can be inspected using the Calibration Kit Parameters window (see below) found
under the Tools menu. From this the kit editor can be launched to modify and create new kits as discussed later
in the section.

The unknown thru calibration method only requires that the thru adaptor be reciprocal: that is, have S,, = S,,.

If calibration data for the If calibration data for the
matched load or through Open/Short is available for the
adaptor is available for the Port 1 kit, check the box

Port 1 kit, check the box(es)

Lol chatn owvindable 5

[ L T Pp— P00 £

Thruidaly swmdshls o Shori g O pee dady gesisble o
Enter details of kit to be il parimeing Dpen sappoiante oreiliieni et rabptannes - THL Seastaich Parameters required
i (¥ LMl fomg w1 Lima 3
used with Port 1 \. Fce 7l 22 | | e W Citr 8 W [no A [ L1 S— T for a TRL calibration
Open et iewrd [ 580 [00 ! Theu fength sl PG | FEHE | (PicoVNA 108 only)
Shot olfest bws) [T 522 [0 e T a2 Fushisct Srasd — ./
Parl 7 Fi nasa pronaren Lend claly swminbis [ Fhari mnd [ pae cady meslsble i
Enter details of kit to be Kit paramatmr lipan capaciancs ceafheiania Ghast rabertance THL Standuird
used with Port 2 2 LipH| [nm Lirm 1 Lra 2
\. 10 g oaNors [Emm CH0 ) [Gm FLUEHH [0 FUGHE [
Dipwsrs i ] [57 00 [0 i FHEEA (i FHLHE I
Shed ofoet bl [I5508 [0 e T D [T Doy i
Elscmsic i 5
Laad P1 K qudl"?lil ol K Aply | ColKEPdier | [ Doas

Use the Cal Kit Editor to
create a new kit based on an
existing kit

Click to load fixed I

SOLT or TRL kits ~ Click to find and  After kits are loaded,
load automated click to apply
E-Cal module

Calibration Kit window. The short/open offsets are in mm in air.

5.4.1 Manual fixed SOLT calibration - insertable DUT

Two Pico calibration kits required: Premium PC3.5 kits SOLT-PREM-M and SOLT-PREM-F or Standard SMA kits
SOLT-STD-M and SOLT-STD-F or alternative calibration kits comprising:

e Open circuit (2 pieces, one male and one female)
e Short circuit (2 pieces, one male and one female)
e Matched termination (2 pieces, one male and one female)
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Forinsertable DUTs the requirement is for two calibration kits, one of each sex. Generally, it is required that the
matched termination should be of good quality and, as a guide, should have a return loss of better than 40 dB.
However, the PicoVNA 106 and 108 allow terminations with relatively poor return loss values to be used and still
maintain good accuracy. This is discussed in Using a matched termination.

5.4.2 Manual fixed SOLT calibration - non-insertable DUT

One Pico calibration kit required: Premium PC3.5 kit SOLT-PREM-M or SOLT-PREM-F or Standard SMA kits
SOLT-STD-M or SOLT-STD-for alternative calibration kit comprising:

Open circuit (1 piece)

Short circuit (1 piece)

Matched termination (1 piece)

Either a characterized through connection adaptor (1 piece) or any uncharacterized reciprocal adaptor

For non-insertable DUTs only a single calibration kit is required. In addition, a reciprocal but otherwise unknown
thru adaptor, or a fully characterized thru adaptor, is required. The latter is supplied with all Pico standard kits.

5.4.3  Open circuit model

The open circuit capacitance model used is described by the equation below, where F is the operating frequency.
Generally, with typical open circuit standards, the effect is small, amounting to no more than a few degrees of
phase shift at 6 or 8.5 GHz.

C,pen = Co+ C;F + C,F? + C,F

open

In addition, an offset length (sometimes referred to as offset delay) can be entered as well as the loss of the
offset line.

5.4.4  Short circuit model

The short circuit inductance is modeled by an inductance component and in addition, a non-zero offset length can
be entered together with the loss of the offset line.

5.4.5 Short and open without models

The PicoVNA 106 and 108 support short and open standards defined by data only. In this case the data is
supplied in the form of a 201-frequency-points table. Each frequency point has three comma-separated entries:
frequency (in MHz), real part of the reflection coefficient and the imaginary part of the reflection coefficient.

5.4.6 Calibration kit editor

As already mentioned, the calibration kit editor can be used to create or edit an existing calibration kit. The figure
below shows the editor window. A typical example is to create a new kit using an existing kit as a template to
speed the process. So, the process would be to first load the existing calibration kit from the Calibration Kit
Parameters window. Type the new kit name in the name box and modify the parameters as needed. Finally, click
Save Kit to save the new kit with a new name.

In the above example, if the existing kit loaded had load data or through data and you want to replace this with
new data, uncheck the appropriate box and then check it again.
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3. Enter ideal through

1. Check if Load or Through 2. Check to use ideal models here

adaptor data is available through model
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4. Click to reset all 5. Click to load and edit 6. After entering all values, click to
values and start again  an existing kit or to use save kit. You will be prompted for Load
it as a template and Through data files as required.

Calibration Kit Editor

The calibration kits optionally supplied with the PicoVNA 106 and 108 provide an economical solution while
retaining good measurement accuracy. They are supplied with SMA or precision PC3.5 (SMA-compatible)
connectors. Refer to the PicoVNA 100 Series Data Sheet for details.

5.4.7 Using a matched termination with poor return loss or
unmodeled short and open

A successful calibration can be carried out without the need for a good-quality matched load. In order to retain
accuracy, it is necessary to provide the instrument with accurate performance data of the matched load to be
used. The data needs to be in a fixed format thus:

Frequency (MHz) S11 (real) S11 (imaginary)

l l l

1.0 -1.7265E-03 7.7777E-05 There must be 201 data lines. Typically these

30.995 -1.6588E-03 3.3093E-04 should cover the band 0.3 MHz to (6.00 GHz or
8.50 GHz). No empty or comment lines are

60.99 -1.4761E-63 5.9003E-04 allowed.

90.985 -1.4653E-63 1.0253E-03

120.98 -1.3841E-063 1.2608E-03

150.975 -1.1924E-63 1.5800E-03

240.96 -1.0884E-63 1.9085E-03

300.95 -8.7216E-064 2.1355E-03

330.945 -7.0326E-04 2.4109E-03

360.94 -5.7006E-04 2.6790E-03

Format for characteristics of matched load

In the case when the models for the open and short are not known, it is possible to enter measured data in the
same format as shown above. This approach can give good results if the open and short can be measured
accurately, particularly at the higher frequencies where it is usually difficult to model components accurately.

When supplied, the data for the through connection adaptor must be in the format shown below. The data must
be a full set of S-parameters with no empty or comment lines. It is important that the data spans as much of the
full frequency range as possible, for example from 0.3 MHz to (6000 MHz or 8500 MHz).
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Freqg (MHz) S11r S11i S21r S21i S12r S12i S22r S22i

0.3 1.1450E-04  -1.8852E-04 ©.9965E-01  -1.0394E-03 9.9947E-01  -7.4717E-04 1.0723E-04  4.9711E-05
40.3 2.9307E-84  1.9923E-04  9.9973E-01  -1.0241E-02 9.9934E-81  -1.0585E-82 2.8715E-04  2.0814E-04
80.3 4.1774E-84  4.3168E-04  9.9922E-01  -1.9672E-82 9.9927E-01  -1.9668E-02 2.8195E-84  2.8897E-04
120.3 5.3415E-04  5.7609E-04  9.9898E-81  -2.9165E-62 9.9855E-01  -2.8852E-02 4.0525E-04  2.8043E-04
160.3 7.1924E-84  6.4942E-04  9.9883E-01  -2.9165E-02 9.9855E-81  -2.8852E-82 4.B646E-04  2.8133E-04
200.3 7.8941E-04 7 .5903E-04 9.9834E-01 -3.8214E-02  9.9846E-01 -3.8128E-02  5.4323E-04 2.2344E-04
249.3 9.9069E-04  7.8162E-04  9.9792E-01  -5.70633E-02 9.9758E-81  -4.7805E-82 5.7273E-04  2.9411E-04
280.3 1.0791E-03  8.0397E-04  9.9715E-01  -6.6419E-02 9.9699E-81  -6.5967E-02 5.7191E-04  2.6551E-04
320.3 1.2779E-03  8.5429E-04  9.9648E-01  -7.5557E-02 9.9625E-01  -7.5449E-02 6.3081E-04  2.9580E-04

and so on, to a total of 2017 frequency points

Format for the characteristics of the through connector. These must be a full set of S-parameters (real and
imaginary).

To add matched load, short and open, or thru adaptor data to a calibration kit, follow the steps below:

¢ Load kit using the Kit Editor (see Calibration Kit)

e Check the Load Data Available box and similarly the boxes for the Thru and Short and Open circuits in the Kit
Editor parameters window.

e If the existing kit already has load, short and open, or through data, uncheck and recheck the appropriate box. If
this is not done, the existing data will be kept and copied to the new Kkit.

o If needed, manually enter the rest of the kit parameters. Ensure that the correct offset is entered.

¢ Click Save Kit

e When prompted, select the data file containing the matched load or the thru adaptor data in the format shown
above.

o Save the kit for future use by clicking the Save Kit button (see Calibration Kit).

Note: When a kit is loaded, any available matched load or thru adaptor data that is associated with the kit will be
automatically loaded.

The calibration kits available for the PicoVNA 106 and 108 come complete with matched load, short and open,
and thru adaptor data. Copy these files to your computer for easy access.

|It is critically important that the correct kit data, with the correct serial number, is loaded.

5.4.8 Using athird-party calibration kit

The PicoVNA 106 and 108 may be used with third-party calibration kits, such as the Keysight/Agilent 85032F, that
are characterized by polynomial coefficient models either in written form or as a text file.

1. Use the PicoVNA cal kit editor (Tools > Calibration Kit > Cal Kit Editor).

2. Uncheck all the "data available" boxes.

3. Enter the four poly coefficients of Open capacitance.

4. Enter only the LO poly coefficient of Short inductance (neglecting the small and HF dominating coefficients)
5. Enter the Short and Open Loss terms.

6. Convert Short and Open offset times (ps) to distance (mm) in air and enter those.

7. The short and open Z, values are not used (assumed 50 Q).

8. Nothing is entered for the Load.

9. As this Cal Kit does not have a Thru, we have left the length as zero. If a Thru is provided, measure the length
(reference plane to reference plane in mm) and enter that to recreate these files.
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- (Cal Kit Editor = O X
Kit Values - Load data available [
Kit name K eysight 85032 0.02
Thru data available [ Useideal Thru model [~ Thrd loss
Short/Open data available [ g \\x
. - - . 002 [
Kit parameters DOpen capacitance coefficients / Short inductance Ideal Thru model o e |
Loss - =
" Female + Male [Gohm/s | | COE-15) W C2E-36) W Electrical length [mm) |20 ‘004
Open offset mm)] {000 0o L (pH) Thiu loss [Gohmds) 20
K p | -0.05
Shart aftset (mm] [0 il F1E-27) fo.00 E3E-45) .00 0o Loss value freq [GHz] 4
-0.08
0 12 4 1] 4.8 [
New Kit ‘ Load Existing Kit ‘ Save Kit Close Fieq (GF2)

10. Save the cal kit file(s) generated by the editor. We suggest including the calibration kit model number, and
serial number if provided, in the file name.

5.4.9 Defining and Using TRL/TRM Calibration Standards
(PicoVNA 108 Only)

Below is a summary explanation of preparation for a TRL/TRM calibration. Further detail can be gained from the
white paper entitled TRL calibration for SMT devices using the PicoVNA 108.

Higher Frequencies - Reference line length

For the TRL calibration of higher frequencies it is generally recommended that the line length, AL, is selected to
provide no less than 20° and no more than 160° of phase shift with respect to the thru length over the band of
operation. In practice, best results are achieved by restricting the range to around 30° to 150°.

The required reference line length can be calculated as follows.

= sa(77)
360 feert

® = phase shift in degrees

f = frequency

¢ = speed of light

Eoff = effective dielectric constant

Itis sensible to avoid lower microwave frequencies in order to avoid skin depth effects. So, keepingto 1.5 or 2
GHz and above may be a good idea.

Note: The absolute value of L is not important.
However, all L/2 sections shown must be identical and be exactly half the value of L.
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TRL on PCB Equivalent TRL setup using coaxial components
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PCB circuit blocks for TRL calibration and measurement

For example, assuming a nominal 50 Q line with resulting effective dielectric constant of 3.35, to achieve 30°
phase shift at, say, 1.5 GHz, we find that:

AL=9.1mm

This reference line length of 9.1 mm would in turn provide 150° of phase shift at 7.5 GHz. So, the useable
bandwidth for this line, as a TRL line standard, is 1.5 GHz to 7.5 GHz.

Lower frequencies - Matched Loads for TRM calibration

The PicoVNA 108 automatically switches to TRM at frequencies below those supported by the TRL reference
line(s). The TRM technique relies on matched loads to set the reference impedance. This approach works well
since good matched loads can easily be implemented at lower microwave frequencies (< 2 GHz). The frequency
range of the TRL reference line is set in the calibration kit definition and is described in the following section.

TRL calibration kit
In order to perform a TRL calibration with the PicoVNA 108, a calibration kit file needs to be created. This can be
done very easily using the calibration kit editor (Tools > Calibration kit > Cal Kit Editor).

- Cal Kit Editor

KitvValues ., ,Nawk\t— Load data available [~ — TRL Standards
Thru data available [~ Use ideal Thru madel [~ Del
Thry loss elay [ps]
Shat/Open data available [ [ [~ Linel il
Kit parameters Open il ici Z Short ind Ideal Thru model ~0.02 I~ Line2 o
Loss . [us] FLIGHz) FH(GHz]
¢ Female & Male (Gommss | | copas) [g5a3 | CHEE o377 Electicallength () [5 Zo0s Compute [0 o U
Open offset (mm) 5767 [23 L [pH] Thiu loss [Gohms] 20 from delay | (g [i] L2
CHE-27) [ C3(E-45) [
Short offset [mm] [3536  [2.4 €27 [31013 (€46) fo1e [208 Loss value freq [GHz] - [ - Fieflection Standard
= 7 oo B ——
(V] 17 4 1 68 85 & Shot 0
New Kit ‘ Load Existing Kit Save Kit | Close | Fréq (G52) | o een

Use the calibration kit editor to create the TRL cal kit file

TRL calibration kit — entering the reference line information
In this example we will use only one of the possible reference lines (‘Delays’) so we check just the box next to
‘Line 1’ to indicate that the cal kit has only one reference line. The Line 2 box is left unchecked as shown above.

We can either enter the electrical delay in ps and click the button Compute from delay to set the frequency range
of the line, or preferably, enter directly a narrower frequency range we wish to assign to the reference line. The
low frequency is entered into the box labeled FL and the high frequency into the box FH. Both values are in GHz.
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TRL calibration kit — entering the Reflect Standard information

The next step is to select whether the Reflect Standard is going to be a short or an open circuit. Click the
appropriate radio button as required. Note that it is only necessary to know approximately the value of the
reflection coefficient of the Reflect Standard. So, for example we could use on-PCB short circuits implemented
with vias to ground. For this, we can enter 100 pH as an approximate value of the inductance into the box labeled
L (pH). Alternatively a more accurate value might be available from design CAD or direct measurement.

Likewise if we chose to use Open reflection standards we would enter a capacitance value at CO.
Finally, we enter the desired Kit name in the top left box and click Save Kit to save the file to disk. We would

recommend indication of this being a TRL Kit with Open/Short reflect standards and possibly its Max frequency
coverage within the file name.
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6 Operation

The PicoVNA 2 and PicoVNA 3 software allows you to program the measurement parameters and plots the
measurement results in real time. The main window includes a status panel that displays information including
calibration status, frequency sweep step size and sweep status. The Help menu includes a copy of this manual.

6.1 The PicoVNA 2 or 3 main window

The PicoVNA 2 main window is shown below. PicoVNA 3 is similar. It is dominated by a large graphics area where
the measurement results are plotted together with the readout of the markers. One, two or four plots can be
displayed simultaneously. The plots can be configured to display the desired measurements.

Marker values
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Instrument Callbratlon Sweep Number of Number of Marker
serial status status measurement averaged values
number points sweeps
USB port Test signal Frequency Measurement Internal temperature
status power in use bandwidth (PicoVNA 108 only)

User interface window

6.1.1 Display setup

Setting up the display is carried out through the Display Set Up window which is called up from the main window
by clicking Display. The window is shown below. The typical sequence to set up the display is as follows:

e Set the number of channels to be displayed by clicking the appropriate radio button under Display Channels

e Select the desired active channel from the drop-down list (can also be selected by clicking on a marker in the
main window on the desired display channel)

¢ Select the channel to set up by clicking the appropriate radio button under Select

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 35



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Operation

Choose the desired parameter to display on this channel from the drop-down list under Parameter / Graph
Type

Choose the desired graph type from the drop-down list under Parameter / Graph Type

Select the vertical axis values from the Vertical Axis section. Optionally, click Autoscale to automatically set
the sensitivity and reference values. Note that reference position 1 is at the top (see second figure below).
Click Apply to apply the selected values

Repeat the above steps for each display needed

Note: The Active Channel must be one of the displayed channels. |

Display Set Up = O X

3. Select channel to set up

S~

Select Parameter f Graph Type

e " CHZ2 Parameter |g4q -
i~ CH3 ™ CH4 Graph LogMag -
Vertical Axis Display Channels
Unitz 1. Select
o dE A ™ CH1 ™ CH1,CH2 .// onechannel,
EISIENCE |0 ~ CH3.CH4 & ALL two-channel or
Fiof P ’ four-channel view
) e Fostion 2 :" Active Channel [ v}
4. Check to show vertical £ psitivit —— 2. Select channel to
scale values on graphs \ ¥ 10 show in the Markers
panel
e Digplay vwalues on graph v
2 Apply Cloze
Autozcale ‘ Py

<

5. Apply settings
before selecting
next channel

The Display Set Up window is used to set up the measurements display
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The colors of the main graphics display can be changed to suit individual preferences. This can be done by
selecting the Color Scheme item from the Tools menu. To set a color, click the color preview box next to the
item name.

Once you have set up a color scheme, you can save and recall it as a Cal and Status or just a Status setting
using the File menu.

-------
.o
o®'

.,

211 Laagh .“.. .".. “‘\ Sensitivity
Reference p--i-==BAliRd o 7 .. [P .
value  SfomR AT et ; , _ | e J00 I

Reference *
position

1805.0000 MHz ' ' ' ' ' "~ 2055.0000 MHz
Editing graph parameters using the mouse
The figure above shows how the mouse can be used to quickly adjust reference position, reference value and

vertical scale sensitivity.for the graph. Drag the indicated values up and down to adjust, or type a new value where
the cursor indicates.

6.1.2 Data markers

Itis possible to display up to eight markers on each display. They are set up by clicking on the Markers button
(see figure below). There are four possible marker modes as follows:

Active marker: The active marker is the marker used for comparison when the delta marker mode (switched on
by selecting a reference marker) is on. One of the displayed markers must be chosen as the active marker.

Reference marker: The reference marker causes the delta marker mode to be switched on. The value difference
between the active marker and the reference markers is shown on the right hand marker display panel.

Fixed marker: A fixed marker cannot be moved and its position is not updated with subsequent measurement
values. It provide a fixed reference point. Only a reference marker can be made a fixed marker. Once a marker is
fixed, it cannot be moved until it is unfixed.

Normal marker: The value of a normal marker is displayed on the right-hand marker readout panel and in lower
resolution readouts below each measurement plot.

Any marker (except a fixed marker) can be moved to a new position by left clicking on it (on any displayed
channel) and dragging it to a new position.

The markers set up form provides a Peak / Minimum Search facility. This places marker 1 at either the peak or
minimum value on the displayed trace on the active channel when the corresponding Find button is pressed.
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Select markers to display

E Markers Set Up

For delta marker mode,
select reference marker

. Active Marker
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The Markers Set Up dialog is used to display measurement markers
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Normal Active Fixed
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Change the marker type by right-clicking on any marker on the active channel. Note that only the reference marker
can be fixed.

The peak / minimum search facility provides a means of placing additional markers to indicate the 3 or 6 dB
bandwidth. If either the 3 dB or 6 dB band box are selected, then clicking Find will place markers 2 and 3 on the
frequency points either side of marker 1 which are 3 dB or 6 dB relative to it. Note that for best accuracy a
sufficient number of sweep points should be used. This will ensure a fine enough resolution to allow accurate
determination of the band points.

6.1.3 Measurement enhancement

The measurement enhancement options are displayed (see figure below) by clicking Enhancement in the main Ul
window. The options available are as follows.

Averages (1 to 255, on a point by point basis)

Trace Smoothing (0 to 10%)

Bandwidth (140 kHz to 10 Hz)

Port 1 Level (+6 dBm to —20 dBm for PicoVNA 106, +10 dBm to —20 dBm for PicoVNA 108; 0.1 dB resolution)
CW sweep time per point (0.5 to 65 ms/point for PicoVNA 106, 0.5 to 220 ms/point for PicoVNA 108)
Reference Plane Extension (manual entry or automatic)

Effective dielectric constant of device under test (manual entry to correct plane extension values)
De-embedding (specify embedding networks at ports 1 and or 2)

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 39



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Operation

¢ Impedance conversion for devices that are not 50 Q

Reference plane De-embedding allows DUT parameters
applies to active to be extracted from measurements
channel measurement including test jig effects

Enhancement Set Up

Set Values Ref Plane [applies to active channel) De-embedding
fverages . [~ Port 1 nebwork
i1-255) |1 Select Units [ mm w Auto Pef ™ Port 2 network
Sr['-lf%hg;]g g Enter'Value [p Eff dielecinic [1 gp
Smoathing [

Measurement [pts]

i De-embed on
De-embed off

*

Current active channel

bandwidth \ Convert Lo

Bandwidh [10kHz = Ch 2, measuing 521 [ System Zo
External 2o

Part 1 Lev (dBm) [5g S

N [-20 o +4} e

ime between | .. . S e

Cw' mode bme  [7 Apply Close ‘ 50 Hel

measurements _—W (015 - B5 ms/pl] [ [
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mode /

Measurements can be converted to a different system impedance by checking
this box and entering the desired impedance (value must be real between 10
and 200 Q). The use of external matching pad is also supported.

The measurement enhancement window

The Bandwidth setting refers to the receiver bandwidth. Maximum sweep speed is achieved with the highest (140
kHz) setting. On the other hand, the widest dynamic range (lowest noise floor) is achieved with the lowest value,
10 Hz. Note that the bandwidth setting used during calibration determines the maximum dynamic range
achievable during measurements. So, consider this when carrying out a calibration. For example, if you need to
carry out measurement over more than, say 90 dB dynamic range, then use a 500 Hz or less bandwidth setting
when calibrating.

The Port 1 Level sets the test signal level. The default value is +3 dBm as this gives best overall measurement
accuracy. However, it may be necessary, particularly when measuring active devices (e.g. amplifiers) to reduce
the test level. For maximum dynamic range, then use the highest power setting. For best measurement accuracy
it is recommended that the calibration is carried out at the same test level as it is intended to use for the
measurement. Whenever the test level is different to that used for the calibration, a ‘?" will be added to the
calibration status indicator on the Status Panel (Fig. 6.1)

The Reference Plane facility allows the reference plane of each parameter measurement to be arbitrarily moved
away from the calibration plane. The value entered applies to the measurement parameter (S,,, S,;, S;, or S,,)
displayed on the active channel. Note that the same plane value will be used for all other measurements on that
same parameter regardless if they are on the active channel or not.

The Auto Reference automatically moves the reference plane. It uses the measurement on the active channel.
This feature is particularly useful, for example, when measuring microstrip devices and it is necessary to remove
the effect of the connecting input and output lines. It takes the effective dielectic constant value entered to
correct the displayed value. Refer to Reference plane extension and de-embedding for more details.

Note: The reference plane must be at 0 mm for the Auto Ref function to work correctly. Also, Enhancement
window changes only take place when the instrument is sweeping.

The Effective Dielectric of the device under test can be entered so that the displayed Reference Plane extension
values (shown on the Enhancement Window) are corrected accordingly when the Auto Ref button is clicked. The
default value is 1.0 and the maximum value allowed is 50.0.
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Note: The reference plane extension value shown in the main window on the markers display panel on the right
is the reference plane extension as shown in the Enhancement window.

The de-embedding facility is explained in detail in Reference plane extension and de-embedding.

The System Z, Conversion facility allows measurements, which are always taken in 50 Q, to be converted to

another impedance that you select. This feature can be useful, for example, for measuring 75 Q devices. The
value of Z, entered must be real (purely resistive) and must be within the range of 10 Q to 200 Q. Whenever this

facility is selected, an indicator is displayed on the top right corner of the graphics display as shown in the second
figure below. Note that when requested, impedance conversion will performed on the live measurement and any
stored memory trace.

There are two possible ways of using the System Z, Conversion facility. For example, 75 Q devices can be
measured using the techniques illustrated below.

‘ VNA ‘ ‘ VNA ‘
Port 1 ? Port 2 Port 1 / \Port 2
RF cable / Connectorized '\ / R
75Q DUT 50Qt075Q RF cable f \

matching pads
(x2) 50 Q test jig 75Q DUT

Impedance matching pads can be usedto measurea A discrete device mounted on a 50 Q test jig is simpler

connectorized device. Use external matching pads and to measure. Calibrate with a 50 Q calibration kit, use de-

calibrate with a 75 Q calibration kit. embedding to remove the test jig and allow
mathematical conversion to 75 Q impedance.

Possible techniques for measuring 75 Q devices
The steps necessary for each of the two techniques illustrated in the figure above are as follows:

75 Q device with connectors

i. Connect 50 Q to 75 Q impedance matching networks (e.g. matching pads) at the ends of the cables
connected to ports 1 and 2.

ii. Inthe Enhancement window, check the Convert System Zo box

iii. Check External Zo match to indicate external matching networks in use

iv. Enter 75 in the Convert System Zo value box and click Apply

v. Proceed to calibrate using a 75 Q calibration kit

vi. Connectthe DUT and start the measurement

75 Q device mounted on 50 Q test jig

i. Inthe Enhancement window, uncheck the Convert System Zo box

ii. Calibrate at the ends of the test cables using a 50 Q calibration kit

iii. Apply de-embedding to remove test jig effects. See Calibration kit for some suggestions.

iv. Inthe Enhancement window, check the Convert System Zo box

v. Uncheck the External Zo match box (in this case mathematical impedance conversion is done by the
software)

vi. Enter 75in the Convert System Zo value box and click Apply

vii. Connect the DUT and start the measurement

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 41



PicoVNA 6 and 8.5 GHz Vector Network Analyzers

Operation

Po= 75]
20801 MARKERS \
). Graph 1511 System impedance
3\ I(.f Ref Plane conversion value
\ / 0.00 mm
/
Marker 1
1501 6000 MHz
-12.829 dB

System impedance chosen is displayed on the top right corner

Note: S-parameters are interrelated, so, when using the Z, conversion facility (and no external impedance
matching networks) without a full set of S-parameters available (e.g. only an S, calibration) the program will

assume values for the unavailable parameters as shown in the following table. A warning will be displayed in
such cases.

s11 S12 S21 S22

1075, j0.0 1075,j0.0 1075,j0.0 1075,j0.0

Values assumed for parameters not available during Z, conversion

6.1.4

The current displayed data on each channel can be stored in memory. Also, each channel can be stored
independently of all others. The Memory Set Up window is used to store the data and this window can be
displayed by clicking Memory in the main window.

Memory facility

Memory Set Up = O 4
Select display Channel Math Trace Hold Select trace hold
channel data to function (memory
store in memory \.. =l {* Data+ Memon e (ff .// will hold poak
" CH3  CH4 | | ¢ Data-Memory " Man values or minimum
values)
Al " Data / Memory " Min
Select math
function (used if
Store Data | Eraze Al | Close Window | \ Display IVEemory
T Math is enabled)
Click to clear
the memory

The Memory Set Up window is used to store data into memory

Once the data is stored, it can be displayed by clicking Display Data and Memory in the main window.

There are three vector math functions available: sum, subtraction and division. The selected function is used
when you select the Display Memory Math function on the main window.

The trace hold is used to store the maximum or minimum values on the memory trace. Trace hold is not available

when group delay is displayed.
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6.1.5

The limit lines facility allows six segments to be defined for each displayed graph. By taking advantage of the
overlapping capability (see below) a maximum of 11 segments can be created The set up window, shown below,
is displayed by clicking Limit Lines in the main window.

Limit lines facility

Overlapping segments

All valid segments entered are loaded in sequence (i.e. segment 1 first) with the each segment loaded having
priority over the previous segment. This feature allows overlapping segments to be loaded. For example, if
segment 1 is specified to cover, say, 400 to 800 MHz, then a second segment can be specified to a section of
this band, for example, 500 to 600 MHz. This would result in a total of three segments—that is, 400 to 500, 500 to
600 and 600 to 800 MHz—even though only two were specified. An example of a complex 11-segment template is
shown in the first plot below.

Alarm

An alarm facility is provided with the limit lines. This provides audible warning during a sweep if any
measurement exceeds the limits set. A visible indication of the last measurement and measurement channel in
error is provided on the status panel where normally the calibration type is displayed. In addition a symbol is
drawn on the trace indicating the last error point detected as shown in the second plot below. The alarm is
available for all graph types except Smith plots.

Check to show limit lines

Check to turn on alarm

v Alarm Enable Limits Apply and Close |
Channel 1 | Charinel 2 ] Chariel 3 ] Chanrel 4
[~ Show Limits fpphy

Segment 1 Segment 2 Segment 3
Start Freq (MHz]  [3000 Start Freq(MHz)  [1958 5475 Start Freq (MHz) [
Stop Freq (MHz]l  [1951 0500 Stop Freg(MHz] 2000000 Stop Freg (MHz) g

Uppes Lirst |90 Upper Limit |2 Upper Limit {1000

Lower Limét |55 Loweer Limt  [.25] Lowser Limit {4 p0n
Segment 4 Segment 5 Segment b
Start Freq MHz] o Start Freq(MHz] o Start Freq (MHz]  [p
Stop Freq MHz] [ Stop Freg(MHz)  [p Stop Freq (MHz) [

Uppes Lirt 1000 Upper Limit  [1000 Upper Limit — [3000

Lower Lirnk 1000 Lower Limit — [L1000 Lower Limit  [1p00

The Limit Lines Set Up allows at least six segments per graph
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Complex Limit Lines templates are possible by overlapping segments
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Limit Lines failure graphical visual indicator

6.1.6  Status panel

The status panel in the main window provides useful information as follows:

¢ Instrument serial number

e Calibration status (S,,, S,;, S;; +S,,, 12 terms or U/T). A question mark indicates that the test power has
been changed from that used for calibration

e Testsignal power. This is the Port 1 signal level

e Sweep status. Indicates whether instrument is sweeping

¢ Frequency step. Step size of sweep

e Sweep points. Number of points in programmed sweep

e Limit Lines alarm if any measurement exceed the set limits (temporarily replaces Calibration status)

¢ Internal instrument temperature (PicoVNA 108 only)

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 44



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Operation

6.1.7  Triggered sweep

Itis possible to synchronize each measurement sweep to an external trigger. Simply click the appropriate radio
button in the main window and ensure that a trigger signal is connected to the instrument’s rear panel Trigger
terminal.

The instrument supports either positive or negative edge trigger depending on the radio button selected on the
main panel. The input impedance is 10 kQ.

Trigger | | | | Trigger |

Trigger selection radio button on main panel (PicoVNA 106)

Trigger At ‘ +Ext ‘ -Ext ‘ b aral I Trigger

Trigger selection radio button on main panel (PicoVNA 108)
Note that Save on Trigger works in +Ext, -Ext and Manual modes only.

When the Manual trigger option is selected, the instrument will wait until the Manual button is pressed before
starting a sweep.

6.1.8  Sweep trigger output

The rear panel Trigger Output terminal provides a 3 V logic output with the rising edge synchronized to the start of
the measurement sweep. The signal goes to 0 V at the end of the sweep. The output resistance is about 500 Q.

6.1.9 Measurement start / stop

The measurement Start / Stop buttons (see figure) are used to start or stop the instrument’'s sweep mode
(measurement mode). This is necessary as functions which require reprogramming the instrument can only take
place when the instrument is idle. The instrument status is shown in the Status Panel as described in the
previous section.

‘ STOP ‘

The Start / Stop Measurement buttons control the sweep status

Note that when the sweep is stopped, the test signal frequency is held at the frequency point at the time the stop
command is received by the instrument. In the case of triggered sweep, by default, at the end of the sweep, the
frequency is held at the last frequency point until the next sweep trigger event is received. This can be changed
from the Tools > Diagnostics menu.
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6.1.10 PC datalink interruption

The data flow between the VNA and its controlling PC can be interrupted by external factors. If the software
cannot restore the link, a message similar to this will appear:

Measure 511 Y

& No Response

Warning message when the link with the PC is interrupted
In such a case:

e Restart the software using the selection in the drop-down menu under Tools

e Switch the VNA off and on again (using the switch on the back) when prompted to do so
e Wait until the front panel lights have stopped flashing

e Click OK to complete the software restart

e Recalibrate the instrument

You should rarely see a ‘No Response’ message. If it happens often, check that the PC is not running other
applications and that the VNA software is not running as a background task when the sweep is on.

6.2 Calibration

The instrument must be calibrated before any measurements can be carried out. This is done by loading a
previous calibration (see File menu) or carrying a fresh calibration by clicking Calibration in the main window,
which brings up the Calibration window as shown here:

Calibration
1. Set sweep Set Sweep Fiequency Cal Kit Loaded
_ . . Pt 1 Poat 2 Pkt 2
parameters —@ Cenve/Span fomat | oo
I FO0003-
F’-“h’ll,l}_ll'H"u PRS-
Uits: ™ GHz & MHz ™ kHz
3. Select
Stan 77508 SNBSS ___— measurement
s C SN CSHes O | required
Stop [pasa 5967 al
I — = - 1
Siep 3 = Irmertable DUTZ cal kiz]

™ Morvrwsertabls DUT [ cal ki)
Swmep . P ™ Morviotabbe DUT furknosn B ca
Foinls |28 D) =] ToA l.'.lsl

" Iretable DUT (TAL ¢ TRM) @——— Pico VNA 108 only

Lewel [cBm]  [30
10 o <]

Rellection Transmizzion 4. Perform required
— oo | ton ||| e o bt
sglrllcivgldth, apply —_ Shat | Though | of required steps may
|| o | | S
] Apply Cal | Choss |

5. On completion,
apply calibration

Note: The frequency sweep is set by entering the start, stop and selecting the number of sweep points.
Alternatively, by entering the centre frequency and span after clicking on the Centre/Span format option box.
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The table below summarizes the calibration types available together with the standards required to complete the
calibration. For best overall accuracy, particularly when measuring low isolation devices with poor return loss
values, a 12-term calibration should be performed.

Required calibration Si S,, S$;1+S,, 12 terms (insertable|12 terms or 8
standards DUT) terms* (non-
insertable DUT)

Fixed SOLT standards |Matched load |Through Matched load Matched load (x 2) |Matched load (x

Open connection Open Open (x 2) 1)

Short Termination (see|Short Short (x 2) Open (x 1)

text) Through Through cable Short (x 1)
connection Thru adaptor (x 1)

Through cable
E-Cal automated SOLT |E-Cal SOLT kit |Not supported |Not supported |E-Cal SOLT kit (use |E-Cal SOLT kit

standards (PicoVNA only supplied port only
108 only) adaptor)

TRL/TRM standards N/A N/A N/A 2x Feed+Shortor |N/A
(PicoVNA 108 only) 2x Feed+Open,

2x Feed+Match,
Thru = 2xFeed and

Thru =
2xFeed+Delay.
Measurement capability|S,, using 3-term |Frequency S,, using 3-term $11:5,1: 51 Sy, S11:851: 812, S,,
error correction  |F€SPonse with o correction  |using 12-term error |using 12-term
isolation Frequency correction error correction or
correction response with 8-term correction
isolation and
source match
correction

Calibration types supported.
* The unknown thru calibration (8 error terms) requires only a reciprocal thru adaptor.

Here is the basic calibration sequence:

i Connect
Set Set test signal Connect test Select tandards at
; ; ; characteristics > : standards a
Start Calibration Kits | o 1| cables to VNA| calibration —X—»
| (calibration orts ¢ > end(s) of test
(tools menu) window) P required cable(s) and
click
Save
calibration | Apply P
End (File menu) |~ Calibration |~
if required

Instrument calibration sequence. This loop is fully automated when using an E-Cal module.

The calibration process involves connecting each standard in turn and clicking. An asterisk will appear once it
has been measured so that the next standard can be done.

Note: For best results, ensure that the instrument is fully warmed up before carrying out a calibration.
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Calibration for measuring non-insertable devices

Mor-insertable DUTs

DUTE:E 3 DUT ¢

/ \ 5 DUT

Female connector Male connector
Use calibrated

adaptor * \

% Calibrate

Measure

At calibration the test port reference planes
canmect directly together (in effect the calibration
"Thru” has zero length, 2ero delay and zero loss).

At calibration, the test port reference planes
cannot connect directly together. A" Thru”
adapter, cable or line must be used and its delay,
match and loss must be known and accounted.

The unknown thru calibration method
measures the Thru delay, match and loss
during the calibration process.

Insertable and non-insertable DUTs

Itis important to be aware of the difference between ‘insertable’ and ‘non-insertable’ devices and the impact on
measurement and calibration technique. The figure above illustrates the difference between an insertable device
and non-insertable devices. The key issue is that with non-insertable devices an adaptor will be required during
the calibration measurement as shown. In order to obtain accurate DUT measurement data, the effect of the
adaptor needs to be removed from the measurements. Some of the possible ways of doing this with the PicoVNA
106 and 108 are as follows:
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At calibration
Calibration used Adaptor removal method Comments
(A) 12-term (insertable DUT) N/A There is no adaptor delay, match or loss to
correct. Two fixed Short Open Load kits

(male and female) or one automated E-Cal
kit are required

(B) 12-term (non-insertable DUT) Calibration removes known Accurate but requires kit with an s-
(previously measured) adaptor |parameter characterized "known" thru
characteristics adaptor standard. Only one calibration kit

is required

(C) 8-Term (unknown thru method) Calibration automatically Accurate and easiest method as it does
removes adaptor effect. not require a characterized thru standard.
Calibration includes One fixed Short Open Load kit required plus
measurement of and removal of any unknown adaptor, cable or line. One
the unknown thru automated E-Cal kit can be used, its Thru
characteristics. will be measured in this case.

At measurement: Alternatively any calibration can be performed and then one or two adaptors added to the test port(s)
to achieve connection to the DUT. The characteristics of the adaptor(s) can then be corrected thus:

Calibration used Adaptor removal method Comments

(D) Any except 12-term or 8-term De-embedding Accurate but requires prior knowledge of
adaptor characteristics or prior
measurement of the adaptor s-parameter
characteristics

(E) Any except 12-term or 8-term Reference plane extension Quick and easy but errors due to loss of
adaptor remain, this method removes the
delay (phase) errors from each test port but
errors due to loss of the adaptor(s) remain.
A further normalization of adaptor loss can
be achieved using an estimate of loss at 1
GHz, the Auto Ref feature or trace Math.
However, mismatch errors will remain.

Techniques for dealing with non-insertable DUTs

Note that for the 8-term method, isolation calibration is done automatically by the software using measurements
taken during the short, open and load steps.

Note that only the 12-term non-insertable DUT calibration and 8-term unknown thru methods support a non-zero
length thru connection. Other calibrations (S,, or S;;+S,, or full 12-term insertable DUT) require a thru connection

of zero length. In effect, this means that the calibration port terminals should be of opposite sexes. In other
words, it should be possible to connect the terminals together without the use of an adaptor. Consequently, the
DUT must be an insertable device. If this is not the case, an adaptor will be needed during the measurement and
its effect will need to be removed by either moving the reference plane or by using the de-embedding facility as
indicated in the table above.

When performing just an S,, calibration it is possible to complete the calibration without doing the isolation

calibration. Simply click Apply Cal after performing the through calibration. The isolation calibration corrects
errors due to crosstalk (see Calibration and error correction) and should be used when measuring insertion losses
larger than about 40 dB. The terminations to use during the isolation calibration can, as a guide, be 50 Q loads. In
some circumstances, such as when testing a highly reactive device (e.g. filter beyond cut-off), a short or an open
circuit may be more appropriate or for best results two actual DUTs with 50 Q loads at their unused ports.

6.2.1 Changing the frequency sweep settings without
recalibrating

If the start or stop frequency or number of sweep points is changed when the instrument has a valid calibration,
you are given the choice to either keep or delete the existing calibration. If you choose to keep the calibration, a
new set of calibration error terms will be automatically generated by interpolation to fit in with the new sweep
parameters. In this case, a “?” is added to the calibration status bar to indicate that operating parameters have
changed from those used in calibration.
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If it is required to change the frequency sweep parameters without recalibrating, then simply enter the new values
(see Set Sweep Frequency values under Calibration) and click Apply. Once the new values are sent to the
instrument, just close the window (click Close Window) to exit. Note that this process will delete all memory
traces and the display data may be invalid until a fresh measurement sweep is performed. Note that new sweep
span must lie entirely within the old sweep span. Extrapolation of calibration is not supported.

Take care when using interpolation, particularly at low frequencies, say below 20 MHz. For example, if starting
with a wide band sweep with large frequency steps, say 500 kHz or larger, then interpolating down to a narrow
band of, for example, 1 MHz to 10 MHz may lead to larger than expected errors.

6.2.2 Calibration steps for S11 measurements

The calibration for S;; measurements performs a three term error correction calibration. Note that if the device to

be tested has a female connector, then a female calibration kit should be used for best results. The typical steps
are as follows:

1. Select the calibration kit (Tools > Calibration kit > Load P1 kit or Electronic Cal Kit (PicoVNA 108 only) >
Apply)

For an E-Cal Kit select the appropriate connection diagram and then Find and Load EasyCal data>Exit>Apply
Set the bandwidth and test power (Enhancement button)

Set the frequency range and measurement steps (Calibration button)

Select S, calibration (in Calibration window)

Connect adaptor and test cable to port 1 of the instrument

An E-Cal calibration will complete application of required standards automatically.

Connect each standard in turn and click appropriate Standard button (in Calibration window)
When all 3 Standards are done click Apply (in Calibration window)

10 If desired, for later use, save calibration (File > Save cal)

11. Connect device to be tested and click Start

CO®NO AWM

Tips:

e For best linearity and dynamic range combination use a test power level of 0 dBm

e For best accuracy calibrate using the same or lower bandwidth than you intend to use for your measurements

e You can remeasure any standard at any stage before completing the calibration. Just reconnect the standard
and click again on the appropriate Standard button before completing the calibration

6.2.3  Calibration steps for S21 measurements

The simple S,, calibration is a frequency response calibration. Sometimes it is referred to as normalization and

only corrects for response characteristics of instrument and external connections. The typical steps are as
follows:

Set the bandwidth and test power (Enhancement button)
Set the frequency range and measurement steps (Calibration button)
Select S, calibration (in Calibration window)

Connect adaptors and test cable 2 to port 1 of the instrument

Connect ends of test cable together (the ‘through’ connection) and select Through (in Calibration window)
Connect 50 Q load to the ends of test cables (to perform the isolation step) and select Isolation (in
Calibration window)

Click Apply (in Calibration window)

If desired, for later use, save calibration (File > save cal)

Connect device to be tested and click Start

ok wpn =

© ® N

Tips:

e For best dynamic range, use a test power level of +6 dBm and calibrate using the same or lower bandwidth
than you intend to use for your measurements

e For best accuracy (linearity) use a test power level of —3 dBm and calibrate using the same or lower
bandwidth than you intend to use for your measurements
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|Pico E-Cal kits do not support this calibration mode. Use instead an 8 or 12 term calibration as below

6.2.4  Calibration steps for S11 and S21 measurements

The S,, +S,, calibration provides three term error correction for S,; measurements and Source match correction
for S,, measurements. The typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kit > Load P1 kit > Apply)

2. Set the bandwidth and test power (Enhancement button)

3. Set the frequency range and measurement steps (Calibration button)

4. Select S, +8,, calibration (in Calibration window)

5. Connect each standard (short, open and load) in turn and click appropriate Standard button (in Calibration
window)

6. Connect ends of test cables together and click Through

7. Connect 50 Q load to the ends of test cables (to perform the isolation step) and select Isolation (in

Calibration window)
8. Click Apply (in Calibration window)
9. If desired, for later use, save calibration (File > Save Cal)
10. Connect device to be tested and click Start

Tips:

e For best linearity and dynamic range combination, use a test power level of 0 dBm

e For best dynamic range use a test power level of +6 dBm and calibrate using the same of lower bandwidth
than you intend to use for your measurements — particularly at the isolation calibration step

Pico E-Cal kits do not support this calibration mode. Use instead an 8 or 12 term calibration as below

6.2.5 Calibration steps for all S-parameters measurements
(insertable DUT)

This calibration provides full error correction for all S-parameters. Typical steps are as follows:

1. Select the calibration kits (Tools > Calibration kits > Load P1 Kit > Load P2 Kit or Electronic Cal Kit (PicoVNA

108 only) >Apply)

For an E-Cal Kit select the appropriate connection diagram and then Find and Load EasyCal data>Exit>Apply

Set the bandwidth and test power (Enhancement button)

Set the frequency range and measurement steps (Calibration button)

Select 'All —Insertable DUT’ calibration (in Calibration window)

Connect each standard (short, open and load) in turn and click appropriate Standard button (in Calibration

window)

7. Click Isolation select the first method on the left (isolation is measured with 50 Q loads on each calibration
port which is the same as the load step in 5 above)

8. Connect ends of test cables together and click Through

9. An E-Cal calibration will complete application of required standards at 6. 7. and 8. automatically.

10. Click Apply (in Calibration window)

11. If desired, for later use, save calibration (File > Save Cal and Status)

12. Connect device to be tested and click Start

ok wnN

Tips:
e For best linearity and dynamic range combination use a test power level of 0 dBm. Use the same or lower
bandwidth than you will use during measurements.

e For best dynamic range use a test power level of +6 dBm and calibrate using the same or lower bandwidth
than you intend to use for your measurements.
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6.2.6  Calibration steps for all S-parameters measurements
(non-insertable DUT)

This calibration provides full error correction for all S-parameters. It requires a calibration kit with a characterized
through connection. Typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kits > Load P1 Kit or Electronic Cal Kit (PicoVNA 108 only) >
Apply)

2. For an E-Cal Kit select the appropriate connection diagram and then Find and Load EasyCal data > Exit

> Apply

Set the bandwidth and test power (Enhancement button)

Set the frequency range and measurement steps (Calibration button)

Select All - Non-insertable DUT calibration (in Calibration window)

Connect each reflection standard (short/open) in turn and click appropriate Standard button (in Calibration

window)

Click Load to measure the Load Standard (in Calibration window)

Connect ends of test cables together using the characterized through included in the calibration kit and click

Through

9. An E-Cal calibration will complete application of required standards at 6. 7. and 8. automatically.

10. Click Apply (in Calibration window)

11. If desired, for later use, save calibration (File > Save Cal and Status)

12. Connect device to be tested and click Start

oMW

© N

6.2.7  Calibration steps for all S-parameters measurements
(TRL/TRM-insertable DUT)

This calibration (supported by PicoVNA 108 only) provides full error correction for all S-parameters. It requires a
TRL/TRM calibration kit realised as 2x Short or 2x Open, 2x Matched Load, a Zero length Line and a known Delay
length line all placed at the end of identical feed structures. Typically these are all realised upon a test substrate
(e.g. PCB) and the Feed structure might be a substrate edge connector or launcher with common length feed line.
Further design details are given in the figure below. Typical steps are as follows:

1. Select the calibration kit (Tools > Calibration kits > Load P1 Kit > Apply). Where the selected kit is a TRL/TRM
kit.

2. Set the bandwidth and test power (Enhancement button)

3. Set the frequency range and measurement steps (Calibration button) noting that the maximum frequency may

be limited by the defined cal kit.

Select All - Insertable DUT (TRL/TRM) calibration (in Calibration window)

Connect each reflection standard (Line/Reflect/Through) in turn and click appropriate Standard button (in

Calibration window)

Click Load to measure the Load Standard (in Calibration window)

Click Apply (in Calibration window)

If desired, for later use, save calibration (File > Save Cal and Status)

Connect device to be tested and click Start

o s

LN

Note that Pico E-Cal and fixed SOLT Calibration kits are not applied during a TRM/TRL calibration.

Reference line impedance correction
Itis likely, for example when using low-cost FR4 boards to carry the TRL/TRM standards that there will be an error
in the characteristic impedance of the TRL reference line. This can be measured using the TDR facility in the
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PicoVNA 108. An example result, in terms of the line’s linear reflection coefficient, is shown in the figure below.

ST KB 5)
= 0ou 0.01 /DI

0.03

0.0

0.m
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-0.5000 ns 1.0000 ne
1. .01 202 3 .01

Reference line Z0 can be determined from the reflection coefficient, measured using TDR

In order to be able to carry out a TDR measurement of the reference line, it is important to bear in mind the
available time resolution (or effective rise time) of the VNA TDR measurement. This is equivalent to the inverse of
the frequency span (stop frequency minus the start frequency) used. By selecting the widest available span, we
end up with a time resolution value of around 118 ps. Therefore, it is sensible to ensure that the overall length of
the reference line, plus the interconnecting lines to the edge connectors, amounts to at least 2.5 x 118 ps. This
will allow an unambiguous TDR impedance measurement to be made in the figure below.

Once the impedance of the reference line has been determined as described, the value can be entered in the
Enhancement Set Up form as shown in the figure below. Once the value is entered and the box next to the
corresponding line is checked, all TRL measurements will be corrected using impedance conversion back to the
system impedance, typically 50 Q. Note that the correction will only be applied over the frequency range
applicable to the line selected.
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Enhancement Set Up — O x

Set Values Ref Plane [applies to active channel] D e-embedding

Enhanced [~ Pork 1 network,

Averages .
r1-25ga1 1 Select Units [ w | Auto Ref -
. [ Port 2 netwark,
Smocthing |3 Enter’/alue | Eit diotectic & 50
ielectnc O« .

[0-10%)
. {" De-embed on
S raathing |5 Lozz [dB), 1 GHz ||:|_|:||:| .
(ptz] Velocity factor € [1.0 v De-embed off
Bandwidth |1kHz THL Line impedance correction - Convert to
. System Z
Part 1 Lew [dBm) |30 Line1 v — |524 1|00 yelem <o
[-20 ko +10] Lne2 I~ — (800 i lon r Enternal 2o
Cw' mode time [ match
(0.5 - BO mz/pt] Current active channel
Eutra zynth settlin .
time [m'l';] g ID_ Ch 1. measuring 511 50 M
Apply Cloze

TRL Measurement can be corrected using known Reference line Z0

This correction of line impedance will reduce any measurement discontinuities between the TRM low frequency
span and the higher frequency TRL line spans. A further reduction of discontinuity may be available from a
complex impedance value for the line, perhaps derived from CAD or Math tools. You might also choose to iterate
to a reactive value through trial of small values.

6.2.8 Calibration for best dynamic range — minimizing the effect
of crosstalk

Instrument crosstalk is a limiting factor when making large dynamic range measurement. This is particularly the
case at higher frequencies, say above 4 GHz. The reason is that some of the crosstalk is dependent on the
loading at the test ports. Therefore, the isolation calibration process can only compensate it fully when the
terminations are left unchanged from those used at the isolation calibration step.
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Enhanced isolation calibration

The PicoVNA 106 and 108 provide an enhanced isolation calibration option. This method makes crosstalk
measurements at the short, open and load calibration steps. In this way it attempts to more closely model the

effect of port termination on the internal crosstalk components of the instrument.

E; Calibration

Set Sweep Freguency
[T CentiesSpan format
Urits: ~ GHz & MHz  kHz

Start |1805.0000

Stop  |2055.0000

Step |1.2500

Fuaintz

Level [dBm] |gD

Sweep (o ~| TDR Opts

Cal kit Loaded
FPart 1/ Part 2

Post 2

Measurement

5N

|SM.B271_Female_cc |SMN.8272_male_combit

52

" 511 +521

[
{* |nzertable DUTE2 cal kits)
" Mondnzetable DUT [1 cal ki)
" Maorinsetable DUT [unknown thia cal]

Al

(+6 to -20) Reflection Transmission
Tina /oo Izalation
CW mode [~ I-rne poink [mz)
uze Start freq Shart Thiough
Enhanced
N | EOE St |
e Apply Cal ! Close Window |

\

The enhanced
isolation calibration
option

The enhanced isolation calibration helps to model the crosstalk more accurately

It is important to note that for best dynamic range, when using the enhanced isolation calibration method, each of
the short, open and load steps need to be made at the same or lower resolution bandwidth than will be used for
the measurement. So, for the ultimate range, each calibration step will need to be done using 10 Hz bandwidth.
This is the downside of the enhanced isolation calibration (slower overall calibration process) compared to
traditional isolation calibration, where only the isolation step need be taken at the lowest bandwidth setting.
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Achieving the ultimate dynamic range using conventional isolation calibration

In cases when two identical DUTs are available, the ultimate dynamic range can be achieved using a
conventional crosstalk (isolation) calibration step as shown in the figure below. In this approach the correct
termination is presented at each port during the crosstalk calibration step. In this way its effect can be removed
accurately over the entire measurement band. Note that when using this technique, only the isolation step need
be performed at the lowest resolution bandwidth. The other calibration steps can be performed at higher
bandwidth settings to speed up the process.

VNA

port 1

x X

identical DUTs

terminations

If two idential DUTs are available, a conventional isolation
calibration step can be carried out as shown

6.2.9 Loading and saving calibrations and status
Load and save calibrations using the File > Load Cal and Status and File > Save Cal and Status commands.

Select the file type according to the type of data you wish to load or save:
e .cal - includes calibration and status data
e .sta - includes status data only

6.2.10 E-Cal 8.5 GHz Electronic Calibration Module - Principle of
operation

The E-Cal module is intended to be used for the calibration of the PicoVNA vector network analyzers. The module
consists of a set of calibration Standards switched in by means of high frequency electronic switches. The figure
below shows the arrangement.

The PC host running the VNA Ul software controls the E-Cal module through the USB connection provided. With
the modules connected to the VNA, the host selects each calibration Standard in turn and records the response
from the VNA. This allows calibration of the VNA to be carried out very fast and with little intervention from the
user. The calibration Standards are accurately characterized in the factory and the results kept in memory within
the E-Cal module which the host reads to compute the VNA error terms and thereby complete the calibration.
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— Standard1l |—

Port A
O— — Standard2 |—

— Standard3 |—

—] Thru —

Port B

PC Host control

o

Simplified block diagram of the E-Cal module

A refinement of the E-Cal module is the inclusion of temperature control. Power from the USB connection is used
to raise and hold constant its internal temperature. This improves the overall stability and accuracy of the module.
Indication of the internal temperature of the module is provided by an LED that switches from red to green to
indicate that the target working temperature of the module has been reached. The figure below shows a
photograph of the module. A second option fitted with female connectors is available.

Micro USB connection
LED indicator

B
4
e “ﬂuBm My ;
-
i g &
i J

E-Cal module connections (male connector option)
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6.2.11 E-Cal 8.5 GHz Electronic Calibration Module - Setting up and
operation

The E-Cal module can be used in three possible arrangements to support calibrations for both non-insertable and
insertable DUTs. A non-insertable DUT is a device with the same sex RF connectors; typically female SMA
connectors, for example. On the other hand, an insertable DUT is one with one female and one male connector.

The available calibration arrangements (for the female connector version) are as follows:

N

F-F DUT

Port 1 e Port 2
> —>

T A B [T

N

Use of the E-Cal module to support insertable DUTs with female

connectors
F-M DUT M-M
adaptor
Port1 ot l Port 2
- —>
Hmm| | A B MH=HIm T
Mark

Use of the E-Cal module to support insertable DUTs with a female
connector on port 1 and male on port 2
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Mark

N
1 MW= 8 Al WH [

4_
Port1l 2 Port 2

M-M

adaptor H—H M-F DUT

Use of the E-Cal module to support insertable DUTs with a male
connector on port 1 and a female connector on port 2

For the male connector version of the unit, similar connection arrangements are possible but a F-F (female-
female) adaptor is used instead, see figures above. Also, the test cable connectors’ sexes shown in the figures
above are reversed.

Selection of the calibration arrangement to be used is carried out as part of the ‘calibration kit selection’
procedure on the LA Techniques’ VNA Ul software. Firstly, connect the E-Cal module to the host PC and, ideally,
allow a few minutes for the indicator to turn green. Once the module is connected, the steps to load the data from
the module are shown below.

Bl LA19-13-04B VNA Control

File Tools Utilities Help - Calibration Kit Parameters
Calibration Kit i
. Load data available [v

Colour Scheme Port 1 Kit name ISN.8271_Fema|e_combined
Hardware ID Thru data available [V  Short and Open data avaiable v
Diagnostic Tests Kit parameters Open capacitance coefficients Short inductance

] Loss L(pH) [o.00
Back Up EEPROM ] O X

P ; ¢ Female " Male (Gohm/s] C0(10™15) W C21036) W

Restore EEPROM ]

; Open offset (mm) {17676 [0.00 Thru length (mm)
Re-Start Program ;' T C1(10°27) W C3(10°-45) W
- \ 7777777 \ Short offset (mm) {15233 |0.00 - - 0.00
Debugging i 7777777

Port 2 Kit name ISN.BZ?Z_maIe_combined Load data available [v  Short and Open data available v
-40

Kit parameters Open capacitance ¢ 2: Select ‘Electronic Cal
Loss
© Female @ Male  (Gohmisl | | copon Kit’ in Kit Parameters form
. . 10715
1: Select Calibration (10715 jooo

Open offset (mm) {17659 [0.00

Kit in Tools menu Shot offset (nm) [17087 oo | | 0 2 9 C300°45) [o.oo
5 5 Elecronic o
Load P1Kit| LoadP2Kit|  Cal Kit Apply | CalKit Editor | Close

Select Calibration Kit in Tools menu
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. EasyCal Set Up - ] X

Select EasyCal use
[ ]
F-M DUT . M-M W
adaptor III[EE]{—L[ED:
B A

Port1 Port 2 - —>
- — Port 1 ® Port 2
1HI FEHIWT
\ M-M
Mark adaptor M-F DUT
& PortA(f)-Port B (f) " PortA(f) - Port B (m) " Port B (m) - Port & (f)

Find and load EasyCal data | I - Exit |

Select the arrangement required and click on Find and load EasyCal data

3: Select arrangement required and
click ‘Find and load..

Note. The module is supplied with an adaptor which is required to deal with insertable DUTs. It is important that
this adaptor is kept safe and connected correctly, with its marked end nearest the module as shown.

Once the E-Cal module’s data has been loaded and connections made, select the Measurement required in the
Calibration form and then click on any calibration Standard button. All Standards will be automatically measured.
On completion click Apply Cal to exit the Calibration form. The VNA is now calibrated and ready for use.
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6.3 Measurements
6.3.1 Return loss

In order to carry out return loss measurements (S,;) the VNA must be calibrated as described before, either S,
calibration only, both S, and S,, or 12-term. The device to be tested (DUT) is then connected to Port 1 of the VNA

as indicated in the figure below. If the DUT can only be connected to the VNA using a cable, then the VNA should
be calibrated at the end of the cable for best results.

VNA

Ll:]Jportz

port 1

S el

DUT

Connect device under test to Port 1 to carry out S11
measurements.

Displaying the results

The measurement result can be displayed by selecting the S,, parameter and an appropriate display graph as
described in Display setup. Note that the measured phase is relative to the calibration reference plane as
discussed in Reference plane extension and de-embedding. The reference plane can be shifted at any time from
the Enhancement window. Note that changes to the reference plane only take place when the instrument is
sweeping.

6.3.2 Insertion loss / gain

To carry out insertion loss measurements (S,,) the VNA must be calibrated with the test cables in place, either
S,, calibration only, both S;; and S,, or full 12-term. The device to be tested (DUT) is then connected between
Ports 1 and 2 of the VNA as indicated in the figure below.

For best results, the arrangement shown on the right hand side of the figure should be used whenever possible.
When using an S,,+S,, calibration this will minimize errors introduced by the load return loss. On the other hand,
when using a 12-term calibration, this will minimize repeatability / cable flexing errors associated with the
connecting cables.
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‘ VNA ‘ ‘ VNA |
| =raiml =
A N A i
Port 1 Port 2 Port 1 Port 2 DUT
.4
RF cable

DuUT

Connect DUT between Ports 1 and 2 to carry out S21
measurements. For best results use the arrangement shown on
the right.

Displaying the results
The measurement result can be displayed by selecting the S,, parameter and an appropriate display graph and

described in Reference plane extension and de-embedding. Note that the measured phase is relative to the
calibration reference plane as discussed in that section. The reference plane can be shifted at any time from the
Enhancement window. Note that changes to the reference plane only take place when the instrument is
sweeping.

6.3.3 Complete 2-port measurement

In order to measure all four s-parameters a 12-term calibration needs to be completed. The arrangement shown
on the right hand side of the figure above is likely to yield best results in terms of repeatability by virtue of using
only one test cable, reduces the effects of cable flexing.

Displaying the results

The measurement result can be displayed by selecting a different parameter for each of the possible four display
graphs, as described in the previous section. Note that the measured phase is relative to the calibration reference
plane as discussed in Reference plane extension and de-embedding. The reference plane can be shifted
(independently for each parameter) at any time from the Enhancement window. Note that changes to the
reference plane only take place when the instrument is sweeping.

Maximizing dynamic range

Refer to Calibration for best dynamic range — minimizing the effect of crosstalk for guidance on achieving the
largest dynamic range.

6.3.4  Group delay

Group delay is defined as the rate of change of phase with frequency:

del s
group_delay = —
dw

In relatively non-dispersive components such as transmission lines, group delay is the transit time through the
line. However, some components such as filters can exhibit negative group delays so care is needed when
attaching an interpretation to group delay.

The PicoVNA 106 and 108 calculate the group delay by dividing the phase change between adjacent sweep
points and dividing by the size of the sweep step. Itis usual to apply some degree of trace smoothing to remove
very rapidly changing perturbations from the trace. Care should be exercised to ensure that genuine sharp group
delay variations are not masked by the smoothing.

Displaying the results
Group delay of any S-parameter can be measured. The result can be displayed by selecting the required
parameter and group delay graph from the Display window as described in Display setup.
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6.3.5 Time domain measurements

The time domain facility allows the display of the time domain response of a network under test. For example,
time domain reflectometry (TDR) measurements can be made by first carrying out an S, calibration using 1024

sweep points. Similarly, time domain transmission (TDT) measurements can be made by first completing an S,,,
calibration using 1024 sweep points. The steps necessary are shown in the flowcharts below.

Seled 511
- e oot Ly| PefomS11 | |(Parameter) and TD
po window) " calibration "1 (Graph Type) ona
display channel

F 3

Conned OUT and _
start measurement [ Set up TD options

Performing a TDR measurement

Seled S
o e oot |_y| Pefoms21 | |(Parameter) and TD
po window) o calibration 7| (Graph Type) on a
display channel

F3

Connec DUT and _
start measurement [ Set up TD options

Performing a TDT measurement

Note that carrying out time domain measurements requires a lot of mathematical processing and therefore each
sweep will be noticeably slower when displaying time domain.

In TD mode, the plot markers display resistance and distance values for S;, and S,,, and distance values for S,
and S,,, as well as levels.

Examples of TDR measurements using the PicoVNA

The trace below shows the time domain response of a 50 cm, 50 Q coaxial cable with an open circuit termination.

The trace goes to +1 relative to the reference indicating a reflection coefficient of +1 for an open circuit. The
window used is rectangular.
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511 TDR
[> 00U | . . . . . . _05UDN

-1.0000 ns ) ] ) o 3.0000 ns
Measured 50 cm line terminated in an open circuit.

The trace below is the same as above except that the ringing either side of the transition has been reduced by the
use of a fifth-order Kaiser—Bessel window. This reduces the ringing but also slows the rise time.

511 TDR

= 00U 05 /D
" : / ___________________________________________________
T0000ns ' ' ' ' ' ' ' 50000 na

Same as previous figure but using the Kaiser—Bessel window.

The type of window, the order of the Kaiser-Bessel window, and the time span over which the signal is displayed
can be selected in the TDR options window, shown below.

E Time Domain Options

X-Axiz Range dc Termination
" Full (o Auto
f Enter 71,72 (" Open circuit
Entering values for T1 (" Shaort circuit
and T2 allow zooming Tins] |5 N
in on a portion of the 20 575 € Resitive

waveform 5000

Window Function

= Hanring Apply

(" Kaizer Bessel

5 Order

Cloze Window

Time Domain Options window allows measurement setup
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Note: To set a time range either starting or ending beyond 161.66 ns, use the Enter T1, T2 facility. However, the
displayed total time span must be less than 166.66 ns.

The plot below shows the same cable terminated with a short circuit. The window is fifth-order Kaiser—Bessel.
This time the trace goes to —1 relative to the reference, indicating a reflection coefficient of —1 for the short
circuit.

511 TDR

[= 00 . . . . . . . . . 0.5 DN
= — e T

-1.0000 ng 9.0000 ng

Measured response of 50 cm shorted cable using Kaiser-Bessel fifth-order window

The trace below shows the effect of increasing the order of the Kaiser—Bessel window to 10. The ripple has been
completely removed but the slope of the edge has been further reduced.

511 TDR
[ 00U 0.5 /DI
[ : ____________________________________________________
I 0000ns ' ' ' ' ' ' ' 50000 na

Measured response of 50 cm shorted cable using tenth-order Kaiser-Bessel window.
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A more complicated example

The trace below shows the response of a 30 cm, 50 Q line followed by 30 cm of 25 Q line terminated in a short
circuit. The window is third-order Kaiser—Bessel. The trace shows the multiple reflections from the discontinuity
of impedance at the connection between the lines and the short circuit termination.

S11TDR
[= 00U 0.5 LD

T0000ns | ' ' ' ' ' 79,0000 ns
Measured response of multiple reflections. See text for details.

The last example is the same 50 Q / 25 Q cable combination but this time the termination is an open circuit. The
response is also displayed over a longer period.

=11 TDR
= 00U 0.5 Lyor

—————————————————————————————————————————————————————————————————

______________________________________________________________________________________________________________________

_____________________________________________________________________________________________________________

0.0000 ns _ . _ 40.0000 ns
Measured response of multiple reflections. See text for details.

Time domain transmission

Time domain transmission (TDT) is similar to the TDR technique except that the transmitted signal is observed.
Traditionally, this is accomplished using a step source and a sampling scope, as with the TDR, but the
transmitted signal at the output of the network is observed rather than the reflected signal at the input to the
network. This technique is useful for measuring the step response or rise time of amplifiers, filters and other
networks.

Examples:

Port 1

time ' time

Expected responses from simple RC networks
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521 TDR
[> 00U | . . . . . . _05UDN

-1.0000 ns 59.0000 ns

Measured TDT for 100 pF series capacitor
=21 TDR

[= 00U 0.5 LYo

——————————————————————————————————————————————————————————

_______________________________________________________________________________________________________________________

_____________________________________________________________________________________________________________________

-1.0000 ns I I I I I I I I I 59.0000 ns
Measured TDT for 100 pF shunt capacitor

6.3.6  Reverse measurements on two port devices

In order to measure the reverse parameters (S,, and S,,), itis necessary to complete a 12-term calibration first
(select ‘insertable’ or ‘non-insertable’ DUT on calibration window as shown in Display setup). The other
calibration options measure only forward parameters. After the 12-term calibration is completed, simply select
the reverse parameter(s) to be required on any displayed channel and start the measurement.

6.3.7 Powering active devices using the built-in bias-Ts

The PicoVNA 106 and 108 include two bias-Ts, which can be used to provide DC bias to the measurement ports 1
and 2. The bias-Ts are rated at 250 mA and can support DC voltages up to 15 V. The DC injection terminals are
type SMB, male, and are located on the front panel. This facility can be used, for example, to provide DC bias to an
active device being measured.

CAUTION
A To avoid causing permanent damage to the internal biasing circuit, do not exceed the voltage and
current ratings.
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6.3.8  Save-on-trigger measurements (PicoVNA 108 only)

The Save on Trigger facility (Utilities menu) provides a convenient way of measuring multi-state devices such as
adjustable gain amplifiers and attenuators or phase shifters.

The Save on Trigger mode works by saving each triggered measurement sweep. Once the desired numbered of
sweeps have been captured (or you stop the measurement), you can selectively plot the available data in various
formats. The data can also be saved in a number of formats and sorted by parameter if so desired. A further

option is to save the entire data set (menu option in the File drop-down menu) for later use. A copy of the Save on
Trigger form (in Utilities menu) is shown below.

Number of sweeps to capture: target and actual

Il save on trigger utility
File Help

Sweeps to capture

Magnitude (dB)

Target number

s
(2to 1024) S_1
Number captured [ 12 S11_2

Apply target 5

Data format Plot captured data _s21_3
to use in plOt 1A [~ Graph parameterrs s21.4

Fomat  [LogMag & =

Ymax Ymin
o [a —
Data to plot -10 !

|"A-Data to plot

s11 vs21 ws12s2 [~
[~ Single freq (MH2) [1000.00
[~ Nomalise to sweep — ,1—

dB

-20
7| Sweeps to plot

2[4

Data to save
™~

Save captured data -25

1 F.]
{ Pl
s sa szl s2” A ! v
.(ﬂﬁ 1“/" { i
@ LogMag+Phase (" LogMag a4 ’}' Ao

" MagsPhase € Phase i
 Reabimaginay (" Mag ’/] \

L\ )

€ Touchstone 4 Vy ‘B
Save -35 4~ I k }

[~ Sort by parameter i ‘u ‘l’
[™ Single freq (MH2) — [1000.00 "l i

|
|

6800.06 7650.03 8500

v

0.3 850.27 1700.24 2550.21 3400.18 4250.15 5100.12 5950.09

Exit ‘ Frequency (MHz)

Save on Trigger settings form and display graph

Setting the target and enabling Save on Trigger mode
Save on Trigger operation is enabled using the check box on the trigger selection area on

~Tn
the main application dialog as shown on the right. When the box is first checked, you will A
be asked to enter the target number of sweeps to be captured. If the trigger mode is set to & Freeun
free run (auto trigger), you will be warned that the Save on Trigger will only operate on a " +Trigger
trigger event, i.e. any trigger mode except free run. & i Thbiger
Plotting captured data S

The captured data for each s-parameter measured can be plotted either in the form of a
family of traces (one for each measurement sweep) over the sweep frequency (as in the
graph above) or as a single trace displaying the value for a chosen frequency over the

sweep number. The latter is useful, for example, to examine the attenuation or phase value of a digital attenuator
at each setting at a given frequency.

[ Save on tigger
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An example of a plot showing the measured data at a
single frequency over the sweep number is shown on
the right. This is a measurement of 10 states of a
programmable attenuator. The horizontal axis
represents each of the states measured (each sweep
measured a different state) and the vertical axis is set
to display the magnitude of S,, in decibels. The user-

requested frequency for the plot is shown at the top.

The settings for the measurement sweeps to be
plotted can be specified as shown below.

Magnitude (dB) - Frequency: 7140.048 MHz

dB

Sweep

Maximum number of graph traces

When plotting s-parameter data over the measurement
sweep (as on the graph above) the maximum number of
traces (one for each measurement sweep) is 16 for
each S-parameter. If all 4 S-parameters are being plotted
this will result in a total of 64 traces. In any case, the
maximum number of trace legends (which identifies the
parameter and sweep number of each trace) is limited

to 38.

Saving the captured data

Plot captured data
Graph parameterrs

Fomst [loghag  w] €-——

Ymax

e

Ymin

a0 R | E—
Data to plot

511 W32 stz M52z

[ SingeheqMHz) [fommn "
™ Nomalise to sweep — 1 H————

Sweeps to plot
14

Select format for the data plots

Set the vertical axis limits

If plotting data for a single frequency, specify it here

Plot data can be normalised to any of the captured sweeps

Examples of valid values: “All” or “1,2,3,4” or “1,2,4-6,7"

The default save mode (‘sort by parameter’ and ‘single frequency’ not ticked) creates a data file for each
captured sweep. The example below shows the result of saving after capturing 12 measurement sweeps. In this,

the user requested the magnitude S, and S,,,.

As can be seen, 12 data files have been created (each has the name provided by you, with the sweep number
appended, e.g. “Step_Attn_5.dat” is the data file for sweep 5) and each data file has 3 columns. The first is the
frequency in MHz, the second contains the requested S,, magnitude value and the third the requested S,,

magnitude.
Mame Date mccl‘iafir:cl Type
] Step_Attn_1.dat 01/01/2020 02:52 DAT File
" Step_Attn_2.dat 01,01 DAT File
| Step_ittn_3.dat 01/01 DAT File
| Step_Attn_4.dat 01,01 DAT File
| Step_ittn_5.dat 01/01 DAT File
| Step_Attn_6.dat 01/01 DAT File
] Step_Attn_7.dat 01/01 DAT File
| Step
| Step_Attn_8.dat 01/01 DAT File
| step
| Step_ittn_9.dat 01,/01 DAT File
| Step
) Step_Attn_10.dat 01,01 DAT File
| step
" step_Attn_11.dat 01,01 DAT File
| Step_Attn_
j Step_Attn_12.dat 01/01/2020 08:52 DAT File

Freq (MHz) $11 (mag) $21 {mag)
/ ’ '

Size m_”f‘itep_Attn_‘I.cE_;jN epad ¢
akp | Eile EEt_F;mat View Help
ok || 8.3 8.00475 1.001E0@
oxg | 42-7985 9.010852 9.947E-1
o | 85-297 0.81759 9.90E-1
: 127.7955 8.01816 9.874E-1
9KE | 178.294 9.01831 9.834E-1
9KE | 212.7925 0.082165 9.819E-1
9KE
9KB
JKB
9KE
JKB
9KE

Default save mode saves a file for each captured sweep. In this example, the user requested the

magnitude of 511 and 521

The default save data mode creates a data file for each sweep.
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External trigger considerations

The save on trigger mode programs the instrument to perform a specified number of sweeps, each synchronized
to an external trigger. You must consider the maximum possible repetition rate of the external trigger. This rate is
a function of factors such as the number of sweep points, bandwidth in use and crucially the speed of the host
PC's operating system in allocating USB communication resources. If the trigger rate exceeds the maximum, the
host PC may miss some trigger events.

The timing diagram that applies to the Save on Trigger mode is shown below. In this it is assumed that the
external trigger is set to rising edge.

The measurement sweep time T, is a function of the number of sweep points and measurement bandwidth
in use. For example, a plan with 201 points using a bandwidth setting of 140 kHz will have Tsweep of 38.3 ms when
measuring all 4 S-parameters. ldeally, the external system that generates the trigger signal will synchronize the
trigger signal to the falling edge of the trigger output from the VNA and make allowance for the speed of the host
PC and its operating system allocating USB communication resources and processing all data and graphics in
time.

Toween t2120ms 4 T,
; 4+ 44— Actual minimumvalue oft
VINA Trigger will depend of host PC speed
output
Externaltrigger —‘ —‘
(pulse width = 1us)

Typically, external trigger should occur 120 ms or more after the end of the sweep but will depend
on speed of host PC.

Note: In the case when the external trigger occurs sooner than the host PC can support after the end of the
sweep time, it is possible that some trigger events will be missed. Controlling the VNA through the API (using the
DLL file supplied) places a lighter load on the host PC (no graphics) so will support significantly faster rates.

Single frequency option

If required, it is possible to request that only data for a
single frequency is saved. Ticking the ‘single frequency’
box and entering the desired frequency results in each File EdiL Furrnal  View Help

saved data file containing a single line of data as shown | 1828. 264 8.83369 9.527C-1
here on the right. In this example the frequency
requested was 1 GHz. The nearest calibrated data point
(1020.264 MHz) is chosen as shown.

| step_attn_1.dat - Notepad

The single frequency option causes a single line of data to

Sort by parameter option be saved.
Itis possible to save the data to a disk file on a parameter by parameter basis by selecting the Sort by parameter
tick box in the Save captured data section of the form. So, for example, it is possible to save all the values of S,,

in a single file with the values for each sweep in separate columns.

For example, choosing to save all 4 s-parameters sorted by parameter will result in 4 separate disk files being
created as shown below:

Mame Date mu:u:lxif’r'iEu:I Type Size

| Step_Attn_S11.dat 01/01/2020 14:55 DAT File 3TKB
|| Step_Attn_S12.dat 01/01/2020 14:55 DAT File 3TKB
| Step_Attn_S21.dat 01/01/2020 14:55 DAT File 3TKB
| Step_Attn_522.dat 01/01/2020 1455 DATFile 3TKB

The ‘Sort by parameter’ option creates a file for each s-parameter.
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The figure below shows part of the contents of a sorted by parameter file created for the S, values. In this

example, the user chose to save magnitude only. As can be seen, the first column has the frequency value in MHz
and subsequent columns contains the S, value of the measurement sweeps captured.

$11 (mag) sweep 1,511 (mag) sweep 2, 511 (mag) sweep 3, ...

_| Step_Attn_S11.dat - Motepad

File Edit Format Yiew Hel

8.3 B8.88475 8.88328 8.88232 B.89868 8.e877 8.88731 B.888

427985 8.81852 8.81528 8.81251 8.81393 8.813% 8.88914 B8.88958

85.297 8.81759 B8.8286 8.81793 B8.81888 8.81785 8.81836 8.818438

127.7955 8.081816 B8.820827 @8.8197 8.820821 8.820821 8.81875 8.81851

178.294 8.81831 8.8196 B8.820878 8.82135 8.82156 8.81043 8.81811

212.7925 8.82165 B8.82048 8.8228 8.82257 8.82254 8.81821 B8.88976
Each column contains the data for each sweep }

Sorted by parameter files have a column for each sweep captured.

6.3.9  Mixer measurements (PicoVNA 108 only)

The PicoVNA 106 and 108 can perform measurements on mixers (frequency conversion devices) with the use of
an external LO source. The user interface software provides support for some commercially available
instruments as well as power sensors (power meters) needed to carry out signal level calibration for improved
measurement accuracy.

An attenuator on the RF
test cable will help reduce
ripple with mixers with
high RF port VSWR but
may impact the accuracy

of the reflection results. RF Test cable LO side LO kﬁ;ide LO
I_._ IF Test cable Lo Lo
— = |
3dB =
IF | RF
RF ——
— I |
IF I!l I
/ Typical spectrum arrangement
Lo

Mixer being tested

Signal Source

LO Test cable

Typical mixer measurement set up
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Measurement selection

The appropriate mixer measurement form is launched from the Utilities drop down menu as shown below:

[l LA19-13-04A VNA Control

File Tools Utilities Help
Signal Generator
Gain Compression
AMto PM

Compare Data

Mixer measurements

External instrument selection

Fornptrveeroe

—>

O X

Mixer measurements sele... -

Measurement selection

| 1. Comnersion loss and RF and IF port match |

2. Port to port isolation |

3. Conversion loss output compression |

Mixer measurement selection

Before setting the measurement parameters, select the source of the LO signal and the means for calibrating the
power level. This is done from the Instruments drop-down menu as shown below. The host PC requires the
Keysight® 10 Libraries Suite to support communication with external instruments such as power sensors through
either the USB or GPIB interfaces. See www.keysight.com. Contact the factory if your preferred instrument(s) is
not on the list in case support may be added at a later date.

- Mixer measurements 1 (conversion loss and RF/IF port return loss)
File = Instruments
1. Select LO source and power meter
Set IF cable loss
RF Frequency [MHz] r50_ W " Sweep L0 lev (dBm)
LO Frequency (MHz) [— [— [V High side W
IF Frequency (MHz) W [— ‘ " Sweep (var RF)

" Sweep (var LO)
Measurement points (51 (2to 201)

[Note: Port 1 power and measurement bandiwdth set in enhancement]
Apply Help

2.Through loss and optional reflection calibration

Options

[::> Select power meter

| y . X
. Selectinstruments Set LO GPIB address (if appropriate) o
Select LO signal source Instrument found
Pico Technology AS108 [
TTi TGRE000 (USB COM)
TTi TGRE000 (GPIB)
Instrument found
Keysight U8480 series sensor PN
Keysight U2000 series sensor
Agilent U8480 series sensor v
Test LD source
Fq (MH2) Level (dBm)
Apply Cloze et 1000.0 100

External instrument (LO source and power meter) selection

Conversion loss and return loss

This measurement is set up using the dialog shown above. It allows the frequency ranges to be set up as well as

the LO power level.

You can chose whether or not to measure return loss by means of the Ignore check box under the Reflection
calibration buttons. If the button is left unchecked, the instrument will perform a standard SOLT calibration to
allow corrected return loss values to be displayed.

Note: The return loss of either the RF port or the IF port will be measured and displayed. If the IF frequency is
swept, then the IF port return loss is measured otherwise the RF port return loss is measured and displayed.

One important advantage of return loss calibration is that the measured conversion loss will corrected for the
effects, for example, of poor mixer return loss. This is sometimes referred to as VSWR correction and is

illustrated in the second figure below.
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Pl Mixer measurements 1 (conversion loss and RF/IF port return loss)
File Instruments
f 1. Set measurement plan
Start Stop

RF Frequency (MH2) [100 540 " Sweep L0 lev (dBm)

=10l x|

LO (MHz) = 110 - 990 ‘ ‘

LO Frequency (MHz) [170 ¥ Highside [10

IF Frequency (MHz) [1g & Sweep (var RF)

" Sweep (var LO)
Measurement points [101 (2to 201)

[Note: Port 1 power and measurement bandiwdth set in enhancement]
Apply Help

2.Through loss and optional reflection calibration

[3s0

User inputs
A

o

Conversion loss display

&n

Conv loss (dB)

Frequency range

Use to calibrate to measure

Start (MHz2) |m Stop (MHz) |5;[\

Reflection Transmissig

its 1 and 2 cal kit

return loss

362 450

Apr18
Short / Open ‘ ‘
ol Return loss display
Apply elp
S
3. Test signal level calibration 312
S
Frequency range _E /_///_v
Stat (MH2) |10 Stop (MHz2) [540 §13
=
Calibrate power level 24
Help /-\
-30

Exit

86
IF Freq (MHz)

362 450

Aditional information |

Mixer measurement setup dialog

-4

-5

-6
Measurement with no VSWR corgection

7 \ Al I\

A M

8 M g >OV\A/\/\n/\ Aln N !
/|G

9 +—— V4 o V

Measurement with VSWR correction

-10

-11

12

0 1000 2000 3000 4000 5000

VSWR Correction can improve conversion loss uncertainty

Isolation and conversion loss compression
The other main measurement options are port to port isolation and conversion loss compression as shown under
Measurement Selection above. Setting each of these up will require selection of the external instruments as
described above under External instrument selection. The corresponding form for each of these set of
measurements provides graphical indication of the calibration steps.

6000

The figure below shows the conversion loss compression setup dialog. As indicated, the need for an external
power meter can be bypassed albeit at the risk of reduced measurement accuracy. On completion of the
measurement the variation of conversion loss with RF port power level and the 0.1 dB and 1 dB compression

points are displayed.
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Mixer measurements 3 (output compression)
File Instruments

1. Measurement plan

RF(MH2) [topg | HisidelO

IF (MHz) |30 LO (dBrm)

LO (MH2) |370 10

RFBm) [17  —> [3 Leew

2. Power calibration

Port 1

Calibrate

[V Skip this step

Leegr

3. Through calibration

‘*

Port 1 Port 2
Calibrate
RF F
Connect

4. Measurement

o x|

pression (dB)

(’/Loss com
N

P—

This step can skipped and power level will be
calibrated using the port 2 receiver sensitivity
stored at the factory in step 3. Lower measurement
accuracy is likely to result.

-17

- - 5
2 9RF level (dBm) ~

Measure

Compression values

Pin (dBm) for 0.1 dB compression  [.33

Exit

Pin (dBm) for 1 dB compression 0.4

Conversion loss compression measurement dialog

6.4 Reference plane extension and de-embedding

The reference plane extension facility on the PicovVNA 106 and 108 allows you to shift the measurement
reference plane away from the value set during calibration. This can be useful in removing the effect of

interconnecting cables or microstrip lines from measurements. The instrument allows independent reference
plane extensions on each of the measurement parameters (S, S,,, S;, 0r S,,).

The loss associated with any plane extension can be entered directly (see figure above) in terms of the loss (in
dB) at 1 GHz. The software assumes that the loss is 0 dB at dc and at other frequencies the magnitude of the

loss is given by the following expression.

Loss = Loss (1 GHz) x V(Freq / 1x10°)

The enhance option in the Auto Ref facility allows the software to compute the loss as well as the optimum

phase offset at each frequency in the sweep plan. This can be very useful to cancel out the effect of loss but
note that some residual errors after using this feature will remain, for example mismatch errors.

The Auto Ref feature assumes a perfect open for reflection measurements. That is, it tries to provide an offset to
leave 0° reflection phase. Similarly, when dealing with transmission measurements, it assumes a perfect zero

length through connection.
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An example of an application requiring the use of reference plane extension is shown below. In this, it is desired
to measure the S, of a device mounted on a microstrip test jig with SMA connectors. In order to remove the

effect of the interconnecting line to the input of the device, the following procedure may be followed:

e Performan S, calibration at the end of the N to SMA adaptor on Port 1
Connect the test jig without the DUT mounted on it

Display the phase of the S, on active display channel

e Click Auto Ref in the Enhancement window

Click Apply in the Enhancement window

The above steps will move the reference plane to the end of the microstrip line. This can be verified by noting that
the displayed phase is close to 0° over the entire measurement band. Imperfections associated with the
microstrip line and coaxial connector, such as loss and dispersion, will mean that some residual phase will
remain. However, with careful design and employing good RF practice for the construction of the jig, this error
should remain small.

After the above steps are completed, the DUT can be mounted on the jig and its S,, parameter measured.

After calibration, For the measurement we want Use the jig without the DUT to
ref plane is here the ref plane to be here help move the ref plane here

| | )
UHH[I: H

O

1
E

Device to
be tested

~—

DUT on microstrip test jig

Example of S,; measurement requiring reference plane extension

Note: The reference plane extension moves the reference plane for each parameter measurement
independently. So, if required for example, different values can be used for S,, and S,,. Areference plane
extension value entered, applies to the active channel measurement parameter (either reflection or
transmission).

In the example above, correction was applied to the S, phase but not S,,. An often-used way to correct the S,,

phase is by using a calibration jig with length of microstrip line equal to the sum of the two sections of line used
either side of the DUT jig (see figure below). Proceed as follows to make S,, and S,, measurements of the DUT.

Reference plane extension for S, correction

e Perform a 12 term calibration (exclude test jig). Ensure that the test cable has connectors of different sex at
each end. Adaptors may be needed to connect the DUT.

e Connect the input port of the test jig without the DUT mounted on it to Port 1

» Display the phase of the S,; on the active display channel

Click Auto Ref in the Enhancement window
Click Apply in the Enhancement window

Normalization for S,, correction

e Connect the through microstrip test line between Ports 1 and 2 of the VNA
« Display the phase of S,, on a non-active channel (keep active channel for S )

e Start the measurement and store data on the S, channel only to memory (use the memory window)

Select Data / Memory for the math function in the Memory window
Select the Memory Math display in the main window
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Use the jig without the DUT to Use a section of line on the jig to
help move the ref plane here compensate electrical lengths
l for S21 measurements

A

o m m

After calibration, For the S11 measurement we
ref plane is here want the ref plane to be here

l
—[ i= Ullll[[

m

VNA

i

DUT on microstrip test jig

Correcting S,, and S,, phase measurements. Reference plane extension corrects S,, measurements and
normalization to a test line corrects S,,,.

The above steps will allow the DUT's S, and S, (or S,, and S,,) parameters to be measured with the right phase

correction. In addition, the loss of the microstrip line will be accounted for. The same approach can be used to
measure S;, and S,,. Note, however, that there will be an error on both measurements due to the imperfections of

the microstrip line and connector interface. With careful design of the jig these can be kept acceptably small but
further accuracy can be achieved by making use of the de-embedding facility described below.

De-embedding facility

A typical measurement jig, as shown below, includes input and output networks which introduce errors to the
measured values of the device under test (DUT). For best measurement accuracy, these networks can be
specified (in the form of 2 port s-parameter files) and then used to extrapolate the DUT’s characteristics.

. Input | | Output .
1 1 ] 1
' network ' DUT ! network '
l | | '
| | ] ]
! Nlg,, ! S21 ! N2, !
' o | o i o |
LN, Y N, oSty sz | Ny, P,
] | ] 1
i - . -— I -— i
: NISIZ : S12 : N2$12 :
1 1 | 1
] \ ] T 1 / 1
A A A
- - a4 \ - N
—_— —
Connector L T L1 Connector

Device to be tested

De-embedding allows the effects of the test jig's input and output networks to be
removed.
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The PicoVNA 106 and 108 allow you to specify S-parameter files (must be full 2-port data) for the input and
output networks as shown in the figure above so that the de-embedding takes place automatically as the
instrument measures the test jig. After first calibrating as usual, follow the steps below to enable de-embedding.

1. Select the S-parameter file(s) that represent the embedding network(s) by clicking on the embedding network
check box(es) as shown in Measurement enhancement. Check box Port 1 Network represents the input
network as shown in the figures in Reference plane extension and de-embedding, and Port 2 Network
represents the output network. The files selected must be full 2-port S-parameter files in Touchstone format.

2. Click on the radio button in the Measurement enhancement window to enable de-embedding.

Once the above steps are completed, starting the measurement will display de-embedded results.

The de-embedding facility relies on S-parameter data for the input or output network (or both) being available.
This data must be in the form of 2-port S-parameter files in Touchstone format.

6.5 Saving data

Measured data can be saved to a file by selecting File > Save Measurements in the main menu. Various formats
are available as shown. In all cases, frequency is saved in megahertz. Note that only the Touchstone format can
later be read back into the instrument’'s memory trace.

Save Measurements EI@
Select Format
i~ Loghag+Phaze
VW 511 I 521 " Mag + Phaze
= Real + Imag
Check to save data after ™ R+m[511, 522)
applying the memory L " TD [magnitude]
math function. f* Touchstone [S2p)
More...
i " Touchstane (S1p] Comment will be added
/F Save uncorected data Touchstane comment | }icl)e;ﬂ\]/\?hfelzl;]sfl'gﬂirssftf:\\éed
Check to save / | — ] format is used
uncorrected data
(specialist use only)
Save Cloze

The Save Measurements window is used to save data

Note: For true compatibility with the Touchstone format, only 1-port or full 2-port S-parameters should be saved.
For example, selecting S, and S, (butnot S,, and S,,) is not Touchstone compliant.

If required, the data can be saved with the memory math function applied as described earlier under Memory
facility. In order to do this, check the Apply Memory Math box. Note that the memory math display function on the
main window must be set otherwise the Apply Memory Math check box will be disabled.

When saving data in Touchstone format, ensure that you provide the file name extension when entering the file
name. Typically, for 1-port networks, the extension “.s1p” is used and “.s2p” for 2-port networks. This will
help when reading back the data files since, by default, only files with these extensions will be displayed.

Note: Data will be saved with any system Z, conversion applied.

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 77



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Operation

6.6 Loading data

Measured data (or data from a circuit simulator) can be read into the instrument’'s memory trace(s) or live trace.
This can be done by selecting File > Load Measurement in the main menu. The file containing the data (in
Touchstone) format is selected by clicking Select Data File.

The data will be read from the file and copied to the appropriate display channel(s). So, for example, assume you
read a data file holding full 2-port data. Further, you have only two channels on display showing, say, S, and S,,,

soonly the S,, and S, data from the data file read will be copied to the memory traces of the displayed channels.
Note: system impedance conversion will apply if turned on in the Measurement enhancement window.

Load Touchstone Data

Load Data

" Loadtomemary & Load to live trace

Select Data File Cloze

Loading data is done with the File > Load
Measurement menu command

6.7 Plotting graphics

You can plot the graphics displayed on the main window using the File menu. A printer setup window will appear
from you can choose the desired printer and set its properties. If required, you can add a label to the plotted
graphics by clicking File > Print / Save Graphics Label.

Add Label

Enter measzurement label balaw — Lahel optionz
|Eali|:urated thru s AT meas of Il:ungj W Date W Status add
Fresigw
" — - Cloze
|Ea|||:urated thru's UAT meas of long ustip line [memony iz UAT) (24042017

A label can be added when plotting or saving graphics

A similar plotting facility exists on the P1dB and AM to PM utilities' control windows.

6.8 Saving graphics

The graphics shown on the main window can be saved in BMP, PNG, GIF, TIF or JPEG formats. This allows
measurement results to be directly pasted into most electronic documents. The facility to save the graphics can
be found under the main File menu. After clicking, a dialog box will appear allowing you to select the name of the
file, its location and format from a drop-down box. As described in the previous section, a label can be added by
clicking File > Print / Save Graphics Label.

The save graphics facility is not available on the P1dB and AM to PM utilities. Instead, the graphics on these can
be captured by pressing the Alt+PrtScr key combination. The image can then be pasted to the chosen document
from the Edit menu.
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6.9 Signal generator utility

This utility allows the instrument to act as a simple CW or sweep signal generator with variable output power.
power. The output can be either port 1 or port 2. The VNA measurement sweep must be stopped first and the

control window, shown below, called from the Utilities menu:
Signal Generator = O X

Frequency and Level

Level [dBm)
[+E to -20]

hooooooo foo

Freq [MHz]

OM

Apply Cloze |

PicoVNA 2 (PicoVNA 106) signal generator utility
control window

Cw Generator Sweep generator

Freq (MHz) Level [dBEm] Level [dBm]
1 [+10 ko -20) Start freq [MHz] Stop freq (MHz]  MNumber of steps Dwell time [ug]  [+10 to -20]

[1000.0000 o0 [1000 |2000 [101 500 oo

Sweep
ol off
Apply | Cloze ‘ Load | Close |
Select output Select output
& Port1 " Port 2 & Port1 " Port 2

PicoVNA 3 (PicoVNA 108) signal generator utility control window

Maximum output level when using the generator utility: see Performance specifications.

In sweep mode, the maximum number of points in the plan is 1001 with a dwell time range of between 250 and

60 000 ps. Note that this dwell time excludes the time to program the synthesizers.

Trigger (PicoVNA 108 only)
The sweep generator mode supports the following trigger modes:

e Free running
e External rising edge
e External falling edge

These three modes can be selected from the main VNA dialog, in the Trigger selection box. Note that the Manual

trigger mode is not supported by the sweep generator.
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6.10 Output power at the 1 dB gain compression point
utility
This utility allows the measurement of the power output at the 1 dB gain compression point (P, 4;) of active

devices such as amplifiers. The measurement can be done at a single frequency or over the entire frequency plan
specified at the last S-parameter measurement calibration. Start the utility from the Utilities menu in the main
window.

P, calibration

Calibration minimizes errors by removing small variations associated with the instrument’'s hardware. The
procedure is simple, as shown below.

e Ensurethatan$,, (orS;, +S,,, or 12-term) calibration has been carried out

e Connect Port 1 to Port 2 as shown on the left-hand side of the figure below
o Enter Input Attenuation and Output Attenuation values (or select Read from file)
e Enter the test frequency (or select Use sweep plan) and click Calibrate

P, 4 test

The basic connection arrangement is shown on the right hand side of the figure below. Note that the input and
output attenuators should be carefully selected to ensure that the DUT compresses whilst preventing the power
at Port 2 of the instrument exceeding the nominal limit of +10 dBm. It is recommended that the following
guidelines are used to estimate the value of the input and output attenuators needed.

P1asoun) ~ Goun ~1 + A = ~5%2dBm

P1dgoun ~ Aup *5 < 10dBm

where: P1dpoum = output power of DUT at the 1 dB gain compression point
G pum = linear gain of DUT
Aiqr Ay = input and output attenuators

The P, 4; test relies on the internally stored factory calibration of the instrument's port 2 receiver sensitivity.

This is used as a power sensor to calibrate the power available from port 1 as well as measuring the output
power from the device under test. The test does not rely on the setting accuracy of the port 1 output level.

‘ VNA ‘ VNA ‘
L | F—=

Port 1 Port 1 ~_Output
RF cable RF cable attenuator

4 4 DUT
N

Input __,
L attenuator

Basic connection guide for P1dB measurements. Calibration connection is shown on the left.
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The instrument makes the measurement by setting the signal source (Port 1) frequency to the chosen value and
then stepping its power from —20 to +3 dBm (PicoVNA 106) or to +6 dBm (PicoVNA 108) in 1 dB steps. The gain at
each power setting is recorded. On completion of the power sweep, a second order curve is fitted over a narrow
section centered on the point closest to the 1 dB gain compression point. The coefficients of this curve allow the
actual P, 45 point to be calculated.

Note: Choose the input attenuator with care. Ensure that there is no gain compression at the start of the power
sweep (—20 dBm at Port 1) and that at least 0.7 dB of gain compression is reached at the end of the sweep (+3
or+6 dBm at Port 1). A “?" will be displayed if insufficient compression has been achieved.

After the attenuator values have been established and the DUT is in place (and powered up as appropriate), enter
the values into the P, 45 control window (figure below). Note that the output attenuation value directly affects the

P.4g Value, so it is important to enter an accurate value that takes into account all losses in the output path,
including any connecting cable that may have been used.

Clicking Start will perform the test, plot the gain and output power curves, and compute the P, 4. This, together

with the linear gain, will be displayed in the text boxes to the right of the Start button. The results can then be
printed (the window as displayed will be printed) or saved as a text file by clicking Print or Save.

K\ P1dB Utility - ] X
" Enter Walues [port1 sweeps -20 to +3 dBm)
-~
Ga ~ T
fout ———_//-_f_é____\ |F"|dB Test  Measurement Tile , . |
1.2 ! ! y | 4 Test Freq [MHz) & estisting cal | |
* U055 r sweep plan
/ [0.00 Input Attenuation (d8) [~ Read from file
_ B4 Output Attenuation [dB) [~ Read from fil
E I-_".H ea ile
b ID-DD Input Cable Loss (dB)
S e
A Measure
yd Calraie” P1dB (dBm)  Gain (dB)
w2 e ' ' [1334 [t408
4 Print ‘ Close ‘
2z 168 1.8 1.2 4 Save |
PFin {dBm)

The P1dB measurement utility control window

Attenuation values from file
When measuring P, 45 using the frequency sweep plan, it is possible to read the input and output attenuation

values from a file. The data is held in a simple text file with one line for each frequency point. The format must be
as follows:

Frequency (MHz), magnitude (dB), phase (degrees)

Note: The number of lines in the file must match the number of sweep points in the sweep plan.
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6.11  AMto PM conversion utility

This utility allows the measurement of the AM to PM conversion factor of a DUT. Generally, it is used for
evaluating the linearity of active devices such as amplifiers. The utility is started from the main Utilities menu,
shown below:

FSt AM to PM Utility = O i
) - Enter ¥alues [Port1 Sweeps -20 to 0 dBm]
!m.PM Test Measwement Title
06} ! |534.@95 Test Freq [MHz)
0.00 Input Attenuation [dB)
~0.2 !
% | — [7117 Output Attenuation (dB)
-]
E.u_z ] | | |.1 0 Pin [dBm) for Readout
- Measure
-08 1 | | i - AM-PM deg/dB
Calbrate™ | |: Stat _{|  [g7
1 : ;
-22 TS A3, B85 -4 0.5 Save Frint Close [
Pin (dBm) |

The AM to PM measurement utility control window

In order to use this facility an S,, calibration (or S,;+S,,, or 12-term) must have been carried out. For best results,

some averaging (e.g. 16) should be used. Further, a second through calibration is suggested to remove residual
phase variations. The steps are summarized as follows.

AM to PM utility (calibration)
e Perform a normal S, calibration (or S,,+S,,, or 12-term); see left-hand connection diagram in Quick start guide

e Call up AM to PM Utility (window shown above)

e Enter frequency required (Test Freq) in megahertz
e Click Calibrate (connection as on left-hand side of figure below)

AM to PM utility (test)

e Connect DUT with attenuators as shown on right hand side of the figure below

¢ Enter attenuator values, input power at which result is required and measurement title
e Power up DUT if necessary

e Click Start

On completion of the AM to PM test, a graph of AM to PM as a function of input power at the DUT input will be
plotted. In addition, the AM to PM factor at the specified input power entered will be displayed in the text box in
the Measure section of the window.
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| VNA |
‘ VNA | L J
% ¥ Output
/ Port 1 RF cable atfcgum
Port 1 /
RF cable
¥ DUT
\ Input __
attenuator

>

Figure: Calibration (left) and test (right) connections for AM to PM test

Note: For best AM-PM results apply some averaging (e.g. 16) and carry out an AM-PM calibration (left hand side
of figure). A'?" will displayed if the requested P, for readout is outside the available range.

6.12 Phase meter utility (PicoVNA 108 only)

This utility allows port 1 and port 2 of the instrument to be used purely as receivers to measure amplitude and
relative phase. The control window for this utility is shown below. The key function on this is the control to set the
frequency. The frequency range is 0.3 to 8500 MHz. Once it is set, the receivers will be capable of capturing input
signals within +60 kHz (typically) of this value. The input level range of signals that the utility can work over is +10
to-46 dBm, typically.

Bl Phase meter utility
Save status  Load status

(=8 |HcH ==/

. Set frequency and bandwidth
Set receiver centre frequency.

Bandwidth
. . Frequency
The receiver capture range is—|
R . h"““—bl MHz =
typically +60 kHz of this value. i Lii
Phase L At lower bandwidth settings
the display resolution increases.
Port 1 and port 2 phase Phase [deg) | |15 tefence
difference T *|1708 @ Portl " -Poit] Notmalise
—y "~ Normalise applies the current phase
Amplitude reading as an offset to zero the reading.
Part 1 Port 2 Port 2/Port 1 [dB)
1156 [1131 [a4 Caliorate |

Arnpliude units: & dBY O dBm

.

. Amplitude calibration provides a
means of reducing the port 1
amplitude error

Phase meter control window

Phase meter utility display resolution
The amplitude and phase displayed resolution is dependent on the receiver bandwidth selected as shown below.

Bandwidth setting Display resolution

> 1 kHz 0.0

>10Hz 0.00

10 Hz 0.000
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Amplitude calibration

The phase meter utility uses the internally stored port 2 sensitivity. Unless otherwise corrected, the utility
assumes that port 1 has the same sensitivity as port 2 which is likely to lead to a larger error than would
otherwise be the case. To reduce this error in the port 1 level reading, click Calibrate and follow the instructions.

The amplitude calibration feature is a simple two-step process where the connections to ports 1 and 2 are
swapped, allowing the software to make the necessary correction at the selected frequency. Note that some
residual errors are likely to remain. These are associated with the impedance mismatch of the ports and
accuracy of the stored port 2 sensitivity. If amplitude accuracy is critical to the measurement, you are advised to
check the amplitude measurement error using an external dedicated power meter.

6.13 Compare data utility

The compare data utility provides a quick and simple way to compare two sets of full S-parameter measurements
taking into account the instrument's measurement uncertainty and optionally, the uncertainty associated with the
reference measurement. Typically this facility can be used to measure a Check Standard and compare the
measurement values produced by the PicoVNA 106 or 108 with those supplied with the Check Standard. This is a
simple and quick way of determining the adequacy of the calibration to be used.

The compare data utility can be found in the Utility drop-down menu. This brings up the dialog shown below.
To use the compare utility, follow these steps:

Perform a full S-parameter calibration for either an insertable or female non-insertable DUT.
Set display graph 1t0 S11, 210 S21, 3to S12 and 4 to S22.
Measure the associated Check Standard.
Using File > Load Measurements command, load the reference measurement of the Check Standard
(supplied with the standard) to the memory traces. This must be a full Touchstone S-parameter measurement
- example file name:
SN10800X.s2p
Launch the compare data utility (Utility > Compare Data).
Load the PicoVNA 106 or 108 VNA uncertainty file. If all connections are made using PC3.5 test leads and cal
kits, use:
Instrument Uncertainty with Premium PC3.5 leads.dat
Otherwise use:
Instrument Uncertainty with Pico Standard SMA leads.dat
These SMA uncertainties are supported by Pico "Standard" test leads, fixed SOLT and E-Cal kits.

rpPON=

oo

7. Load the reference measurement uncertainty file:
Check Standard Reference Measurement Uncertainty.dat
8. Check the Ignore reference uncertainty check box only if comparing two measurements of the same Check
Standard on the same VNA made at different times or in different environments.
9. Click the Compare button to perform the comparison and display the results.
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Measurement uncertainties are loaded in here

-
F Compare data (=] |
Set Measurement Uncertainty / Enter heading to add to displayed comparison results
This |
|
Select file holding data® Select fie holding data (& lonore eference I
uncertainty |
Compare Close
\
[Test passed] -
W
511 Measurement |
Freq (MHz) S11Mg S11ph RefS11Mg Ref 511 ph DeltaMg Deltaph UMg) Ufph)  Ref UfMg) Ref Ulph) Total U[Mg) Total Ufph) Pass/Fail [
10.00 2819 17762 2919 177.62 00 0o 2.50 150 0.00 00 250 150 Pass I
39.95 <3398 2697 3397 -28.92 =02 -05 20000 360.0 0.00 00 200.00 3600 Pass
69.90 3130 40.05 31.29 40.00 01 05 200.00 360.0 0.00 00 200.00 360.0  Pass |
93,85 3215 10904 3216 108.96 0 03 20000  360.0 000 00 200.00 3600  Pass
12980 3125 -166.78 -31.26 -166.63 01 15 20000 3600 0.00 0o 200.00 3600  Pass
159.75 3030 9873 3030 -38.66 00 07 20000 360.0 0.00 00 200.00 360.0 Pass
18970 2883 2436 2890 2429 01 07 250 150 000 00 250 150 Pass
21365 2725 23923 27.25 2827 00 02 250 150 0.00 00 250 150 Pass
24960 2321 7617 28.21 7812 01 05 250 150 000 00 250 150 Pass
27955 3423 17417 3425 17418 02 1] 200.00 360.0 0.00 00 200.00 3600 Pass
309.50 31.74 10299 3174 10292 00 06 200.00 360.0 0.00 0o 200.00 360.0  Pass
339.45 2968 -3446 2968 34.48 00 02 250 150 0.00 0o 250 150 Pass
363.40 2943 1383 2943 1377 00 06 250 150 000 00 250 150  Pass
39935 3440 7817 34.40 78.24 00 07 20000 3600 0.00 0o 200.00 3600  Pass
42930 3791 17198 3792 A171.83 01 15 20000 360.0 0.00 00 200.00 3600 Pass
459.25 3370 7839 3372 -78.30 02 03 20000 3600 0.00 0o 200.00 3600  Pass
489.20 3077 1381 3077 1383 00 02 20000 360.0 0.00 00 200.00 3600 Pass
51915 3160 4635 31.61 4688 01 07 20000 360.0 000 00 200.00 3600 Pass
54310 31.20 13051 -31.20 13057 00 06 200.00 360.0 0.00 00 200.00 3600 Pass
573.05 3116 157.42 3117 -157.39 )] 03 20000 360.0 000 00 200.00 3600  Pass
609.00 2899 -8080 2899 80.79 00 0 250 150 0.00 0o 250 150 Pass
630.95 27.97 -2013 2797 2013 00 00 250 150 0.00 00 250 150 Pass
668.90 2878 50.53 28.78 50.54 00 ] 250 150 0.00 0o 250 150 Pass A
L 4

Data comparison dialog

Defining uncertainties

Measurement uncertainty is defined by means of text file as illustrated below. The definition is made up of
several segments. Each segment refers to reflection [REFLECTION] ortransmission [ TRANSMISSION] with
an entry for the applicable range in dB followed by the frequency range (in MHz). After the frequency range entry,
the magnitude uncertainty in dB is specified followed by the corresponding phase uncertainty in degrees.

[Default uncertainty for LA19-13-04 6GHz VNA. Apr 2017]
[REFLECTION]
[RANGEDB]
[FhEa)

FREQ
One segmept of o & 359999
the uncertainty definition Inacoe]
[QHASE]
8

[REFLECTION]
[RANGEDB]
-15, 0
[FREQ]

2, 6100
[MAGDE]

0.5
[PHASE]
4

[REFLECTION]
[RANGEDB]

The uncertainty definition is made up of several reflection and transmission segments. A
reflection segment is highlighted above.

Itis possible to define the uncertainty by a polynomial. To do this, follow the [ MAGDB ] keyword with the keyword
[POLY ]. Then, the uncertainty can be define by means of 3 coefficients, say, K,, K;, and K,. The uncertainty for
given measured absolute magnitude value in dB, M, is given by:

U, =Ky + KiM + K,M?

The same approach can be used to defining the phase uncertainty. That is, add the keyword [ POLY ] after the
[ PHASE ] keyword.

The data compare utility resolves the total combined uncertainty as follows:

Ug = |UZ+ U3
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In the above, U, is the uncertainty associated with the PicoVNA unit and Uy is that provided with the reference
Check Standard.

6.14 Closing down the software

You should formally shut down the user interface window before switching off the VNA. This allows the software
to save the calibration and status and update the instrument’s log file. The sequence is shown below:

PicoVNAZ Control

Stop File Tools Utilities Help
sweep
Load Cal and Status
i Save Cal and 5tatus
Select ‘Exit’

=, Print Graphics
from ‘File’ menu

Save Graphics

y Add Graphics Label
Switch off VNA Save Measurements
Load Measurements
Exit
End ] g .

Formally closing down the software saves the current calibration

Closing the program by clicking the top right-hand X button will end the program without saving anything. A
warning will be issued.
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7 Performance verification and maintenance

We recommend that the instrument is checked periodically for safety (chassis grounding, fan operation, clear
ventilation grilles and operator markings) and compliance with the stated electrical specification. The table below
shows suggested parameters that should be checked as part of the calibration process. Note that the ventilation
inlets should be checked as described later.

Measurement DUT Conditions Calibration type
S,, and S,,, magnitude and |20 dB attenuator 51 points sweep 12-term
phase 0.3-6000 or 8500 MHz

1 kHz BW

+3 dBm test level
S,, and S,,, magnitude and |A known mismatch at ports |51 points sweep 12-term
phase 1Tand 2 (-16 dBorworse |0.3-6000 or 8500 MHz

return loss) 1 kHz BW

+3 dBm test level
or
$,1.8,1,S,,and S, Mismatched attenuator (> |51 points sweep 12-term
magnitude and phase 10 dB attenuation and =16 |0.3-6000 or 8500MHz

dB or worse return loss) 1 kHz BW
+3 dBm test level

Suggested annual instrument verification / calibration schedule

We recommended that you compare the measured results with the values provided with the standards and verify
that they are within the combined uncertainty of the instrument and the provided reference measurements. The
frequency should be set to agree with those available(s) for the standard used. The recommended test
arrangement is shown below. The results should be within the instrument’s quoted uncertainty as detailed in the
following section. Allowance should also be made for the uncertainty of the standard reference values.

‘ VNA ‘
Port 1 Port 2
Stable -~
RF |
cable DUT (for example

mismatched attenuator)
Performance verification arrangement

Tip: A data compare utility is provided in the PicoVNA 2 and 3 software that can be used to compare the
measurements, taking into account the uncertainty of the instrument.

Note: The Pico TA430 and TA431 check standards can be used in this verification but they have too much
uncertainty to make a confident verification to the full performance specification of the PicoVNAs. Nonetheless,
the uncertainty of the verification, given in the result from the compare utility, may be low enough for the
application. If sufficient, the use of either TA430 or TA431 of course significantly reduces ownership costs and
increases the regularity at which a verification can be made.
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7.1 Measurement uncertainty

The measurement uncertainty figures below are based on calibration (12-term, insertable device, with -3 dBm
test power and using 10 Hz bandwidth) using the premium PC3.5 mm calibration kits optionally supplied with the
instrument. The figures for S,, and S,, assume that the DUT has a value of S, or S,, of less than 0.2. Similarly,

the figures for S;, and S,, assume the DUT has a value of S,, or S;, of less than 0.2. Other external factors such
as connector and cables effects are excluded.

Power Frequency Magnitude Phase
-15dBto 0 dB Freq <2 MHz 0.7 8°
Freq >2 MHz 0.5 4°
-25dBto-15dB Freq <2 MHz 0.8 10°
Freq > 2MHz 1.0 6°
-30dBto -25dB Freq < 2MHz 3.0 20°
Freq > 2MHz 2.5 15°

Reflection (S, S,,) measurement uncertainty

Power Frequency Magnitude Phase
+0 dBm to +6 dBm Freq <2 MHz 0.4 6°
Freq >2 MHz 0.2 20
-40 dBm to 0 dBm Freq <2 MHz 0.3 2°
Freq >2 MHz 0.1 1°
—-60 dBm to —40 dBm Freq <2 MHz 0.5 8°
Freq >2 MHz 0.3 4°
—-80 dBm to —60 dBm Freq <2 MHz 2.0 15°
Freq >2 MHz 1.5 12°

Transmission (S,,, S,,) measurement uncertainty

7.2 Routine maintenance

Ventilation grilles

Check that all ventilation grilles are clear of any debris, dust or any other material that may impede the flow of air.
Particularly, check the vents in the bottom panel of the instrument. It is advisable to brush these to remove any
gradual build up of dust.

| Failure to clean the ventilation grilles may lead to overheating and eventual failure of the instrument.

Front panel connectors
Routinely inspect the Port 1 and Port 2 N-type connectors for signs of damage or dirt. Use connector-saver
adaptors (male to female through) where frequent connection and disconnection are likely.
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8 Performance specification

The instrument’s performance specification is given below. Unless otherwise stated, the figures apply with 10 Hz
resolution bandwidth, at —3 dBm test power, 12-term calibration (for insertable DUT) using the enhanced isolation
option, at an ambient temperature of 23 + 1 °C and 60 minutes after power up.

Measuring functions
Measuring parameters

Error correction

Display channels
Traces
Display formats

Memory trace
Limit lines
Markers

Marker functions

Signal source characteristics
Frequency range

Frequency setting resolution
Frequency accuracy

Frequency temperature stability
Harmonics (-3 dBm output level)
Non-harmonic spurious (typical)
Phase noise (10 kHz)

Output power

S11:S21, Sgp Sy
P,4s (POwer at 1 dB gain compression)

AM to PM conversion factor (PM due to AM)
PicoVNA 108 only: Mixer conversion loss, return loss,
compression and port isolation.

12 error term full S-parameter correction (insertable
DUT)

12 error term full S-parameter correction (noninsertable
DUT)

8 error term full S-parameter unknown through
correction (noninsertable DUT)

S11 (1-port correction)

De-embed (2 embedding networks may be specified)
Impedance conversion

S21 (normalize, normalize + isolation)

S21 (source match correction + normalize + isolation)
Averaging, smoothing

Hanning and Kaiser—Bessel filtering on time-domain
measurements

Electrical length compensation (manual or auto)
Effective dielectric constant correction

4 channels (CH1, CH2, CH3, CH4)
2 traces per display channel

Amplitude (logarithmic and linear), phase, group delay,
VSWR, real, imaginary, Smith chart, polar, time domain

One per display channel
6 segments per channel (overlap allowed)
8 markers

Normal, A marker, fixed marker, peak / min. hold, 3 dB
and 6 dB bandwidth

PicoVNA 106: 300 kHz to 6.02 GHz
PicoVNA 108: 300 kHz to 8.50 GHz

10 Hz

+10 ppm (23 + 3°C)

+0.5 ppm/°C (15 to 35°C)

-20 dBc max

—40 dBc typical

-90 dBc/Hz (0.3 MHz to 1000 MHz)

-80 dBc/Hz (1000 MHz to 4000 MHz)
-76 dBc/Hz (> 4000 MHz)

PicoVNA 106

Up to 4 GHz: +6 to —20 dBm

>4 GHz: +3to —20 dBm

PicoVNA 108

Up to 6 GHz: +10 to —20 dBm

> 6 GHz: +6 to —20 dBm
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Signal source characteristics

Power setting resolution 0.1 dB (nominal)
Output power accuracy +1.5dB
Reference input frequency 10 MHz 6 ppm
Reference input level 0 +3dBm
Reference output level 0+3 dBm
Sweep functions
Sweep type Linear frequency sweep, CW time-based sweep, power
sweep (P, 45 utility)
Trigger modes Free run
Option to capture up to 1024 sweeps of datain all Positive trigger
modes except free run. Negative trigger
Manual trigger
Sweep time Bandwidth S,1:S51 S41%S,,  |Full 12- or 8-term
10 MHz to 6 or 8.5 GHz, 201-point trace length. For other calibration calibration
lengths .
and bandwidths the sweep time is approximately: 140kHz ::8518 (PicoVNA ;33,; ::2 (fi(r) ms and
Toup(S) =N (Tun * Fon / Raw) 20 ms (PicoVNA ~|PicoV/NA 108)
where: 108)
N = number of frequency points
Tyn(S) = minimum time / point (s2p: 167 ps; s1p: 85 ps) 1(:(kHZ 37 ms 72ms
Fgw = bandwidth settle factor (s2p: 1.91; s1p: 0.956) 1kHz 0.21s 0.42s
Rg\y = resolution bandwidth (Hz) 100 Hz 1.94s 3875
10 Hz 19.2s 384s

For sweep repetition period, add software rearm time:
T \qy = @verage 6.5 ms or worst case 50 ms LF Adder (for  1.25ms/pt 2.5ms/pt

For markers on, increase T ), by 39 ms ?;%TJL%VZY point
< 2.5 MHz)

Number of sweep points, VNA mode 51, 101, 201, 401, 801, 1001, 2001, 4001, 5001, 6001,
7001, 8001, 9001, 10 001

Number of sweep points, TD mode 512, 1024, 2048, 4096

Receiver characteristics

Resolution bandwidth 140 kHz, 70 kHz, 35 kHz, 15 kHz, 10 kHz, 5 kHz, 1 kHz,
500 Hz, 100 Hz, 50 Hz, 10 Hz

Averaged displayed noise floor (dB): Band Typ. Max.

S, calibration PicoVNA 106

10 Hz bandwidth 0.3t0 10 MHz -110 -100

1Tzs{f‘tvscrfll'tgsetserminated as during isolation calibration 10MHz to 4 GHz -1s ~108

step 4t0 6 GHz -110 -100
PicoVNA 108
0.3to 1 MHz -100 -90
1 MHz to 6 GHz -124 -110
6108.5GHz -120 -100

Dynamic range (dB) See figure below

Bandwidth 10 Hz

Maximum test power +6 dBm (6 GHz), 0 dBm (8.5 GHz)

16 averages

Test ports terminated as during the isolation calibration

step. Isolation calibration refreshed as described in

Calibration for best dynamic range.

Temperature stability, measured afteran S,, 0.02dB/°C (f < 4 GHz)

calibration, (typical) 0.04 dB/°C (f = 4 GHz)

Trace noise (dB RMS) Bandwidth  |Typical Maximum
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Receiver characteristics

Full band 10 kHz PicoVNA 106: 0.000 8 0.002

Testlevel 0dB PicoVNA 108: 0.000 6

201-point sweep covering 1 MHzto 6 GHzor 8.5GHz |70 kHz 0.003 0.005
140 kHz PicoVNA 106: 0.005 0.01

PicoVNA 108: 0.006

Test port characteristics

Load match Corrected: 40 dB min., 46 dB typ.
Uncorrected: 16 dB (PicoVNA 106), 15 dB (PicoVNA 108)
typ. uncorrected

Source match Corrected: 40 dB min., 46 dB typ.
Uncorrected: 16 dB (PicoVNA 106), 15 dB (PicoVNA 108)
typ. uncorrected

Directivity (using PC3.5 cal kit) Corrected: 40 dB min. corrected, 47 dB typ. corrected

Crosstalk (dB, corrected) Band Typical Maximum

Test ports terminated with short circuits. PicoVNA 106

Value is average displayed noise level. 03 kHz to 2 MHz |-100 ~90
2MHzto4GHz |-110 -90
4GHzto 6 GHz |-100 -90
PicoVNA 108
0.3kHzto2MHz |-100 -90
2MHzto6 GHz |-110 -90
6 GHzt0 8.5 GHz |-100 -90

Main test ports maximum input level +10 dBm, typ (0.1 dB compression)

(1 dB compression)

Main test ports maximum input level +20 dBm (PicoVNA 106)

(no damage) +23 dBm (PicoVNA 108)

Main test ports connectors Type N (female)

Bias-T maximum current 250 mA

Bias-T maximum DC voltage +15V

Bias-T current protection Built-in resettable fuse

Bias-T DC port connectors SMB (female on front panel)

Sweep trigger input voltage Low:-0.1to+1.0V

High: +2.0to+4 V

Mixer measurements (PicoVNA 108 only)

Frequency range 0.3 to 8500 MHz

Input power sweep range -17 to +10 dBm (6 dBm for F > 6 GHz)

Input power sweep step 0.5 dB (nominal)

LO source External, required

Power level calibration External power sensor supported with option to use
internal receivers with reduced accuracy

Measurements Conversion loss, return loss, isolation and compression

Accuracy (conversion loss with return loss correction  |0.2 dB (typical)

applied)

Display format Graphical, conversion loss, return loss, isolation and

compression

P1dB utility
Frequency range 0.3 to 6020 MHz or 8500 MHz
Input power sweep range PicoVNA 106: —20 to +3 dBm

PicoVNA 108: =20 to +6 dBm

pvug-5 Copyright © 2017-2022 Pico Technology Ltd 91



PicoVNA 6 and 8.5 GHz Vector Network Analyzers Performance specification

P1dB utility

Input power sweep step 1 dB (nominal)

P1dB calculation method 2nd order curve fit

Display format Graphical, gain and output power
Accuracy 0.5 dB (typical)

AM to PM utility

Frequency range 0.3 to 6020 MHz or 8500 MHz
Input power sweep range -20to 0 dBm

Input power sweep step 1 dB (hominal)

AM to PM point calculation method 2nd order curve fit

Display format Graphical, phase conversion (deg / dB)
Accuracy (Port 2 power +5 to =20 dBm) 1° (typical)

Signal generator utility

Frequency range 0.3 to 6020 MHz or 8500 MHz
Output power PicoVNA 106: —20 to +3 dBm
PicoVNA 108: -20 to +10 dBm
Setting resolution 0.1dB
Output power accuracy +1.5 dB max
Group delay
Range (180° maximum phase shift per frequency step) |z = %;
where Af is the aperture frequency
Aperture frequency Frequency sweep step size
Accuracy AT = P;;fésoei}m’

Data handling

Calibration data Store / Recall on disk

Calibration kit data Store / Recall on disk

Print measured data (graphics) To any printer installed on host PC
Save measured data (graphics) To disk

Measured data Store on disk

Measured data (Touchstone format) Store on disk

Measured data (Touchstone format) Recall to memory trace from disk

Statement of Volatility: No user data, calibration data or user settings are stored on the device.

Miscellaneous

PC data interface USB

PC minimum requirements Microsoft Windows 7, 8 or 10
2 GB RAM or more
200 MB hard disk storage on C: partition
Display resolution of 1280 x 720 to run PicoVNA

software
External dimensions (L x W x H) 286 x 174 x 61 mm
Weight 1.85kg
Temperature range (operating) +5°Cto+40°C
Temperature range (storage) -20°Cto+50°C
Humidity 80% max. (non-condensing)
Power source DC, 121015V

PicoVNA 106: 1.85 A peak, 22 W max.
PicoVNA 108: 2.1 A peak, 25 W max.
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Dynamic range (PicoVNA 106)
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Dynamic range (PicoVNA 108)
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9 Troubleshooting guide

CAUTION

The product and accessories contain no user-serviceable parts. Repair, servicing and calibration
require specialized test equipment and must only be performed by Pico Technology or an approved
service provider.

Symptom Possible Cause Solution
Instrument does not power up e Power not applied e Check DC connection
o Incorrect supply e Check external supply
PicoVNA 2 or PicoVNA 3 software |e Driver not installed e See Switching on
unable to communicate with the e Link interrupted e Restart instrument and software
instrument
Instrument sweeping but display not |e Data link interrupted e Restart instrument and software
refreshing
‘Last Calibration not found’ message |e C:\User\Public\Documents\|e Restore folder. Set up display and
on power up PicoVNA2 (or PicoVNA3) calibrate. Exit the software using File

> Exit menu command. This will save
the current calibration in a file

named defaultcal.cal.

directory deleted or corrupted

Diagnostics Tests (under Tools e Data corruption e Restart instrument and software.
menu) fail Ensure that test cable used is in
good condition.
Error reading data files ¢ Invalid format e Check for correct format / ‘# line
e Too many lines e 10007 lines maximum
e Leading space(s) e Remove leading spaces from data
lines

Diagnostics tests

Itis possible to run self-check tests on the instrument. This facility (Diagnostic Tests) is available from the Tools
menu shown above. In order to complete the tests a low loss cable is required to link Port 1 to Port 2. The tests
carry out the following checks.

Synthesizers: test that they remain in lock over the frequency range
Test signal: test the level range and step size

Receiver levels: test that the receiver is operating at normal signal levels
Receiver crosstalk: test that raw crosstalk remains below limit

Receiver DC offset: test that this is at normal level
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Hardware Diagnostics = [l X
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Test Signal Levels |I:IK
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terms to file _ Close Return to start after sweep
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data to file @ TIELENE = “es f¢ Mo

data

The Diagnostics Tests perform internal checks on key components

If any of the tests returns an error, check connectors and linking cable. If this does not resolve it, restart the
instrument and the software. After pressing reset, wait until the front-panel channel activity indicators have
stopped flashing to continue with the tests.

Calibration error terms and raw receiver data
The diagnostic tests dialog (figure above) also provides the facility for retrieving the calibration error terms and
raw receiver data. The latter can be helpful for users wishing to carry out their own calibration procedure.

Back up/restore EEPROM
This facility allows the internal ROM (read-only memory) of the instrument to be backed up or restored. This
facility should only be required by service or repair personnel.
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10  Warranty

Pico Technology warrants upon delivery, and for a period of three years unless otherwise stated from the date of
delivery, that the Goods will be free from defects in material and workmanship.

Pico Technology shall not be liable for a breach of the warranty if the defect has been caused by fair wear and
tear, willful damage, negligence, abnormal working conditions or failure to follow Pico Technology's spoken or
written advice on the storage, installation, commissioning, use or maintenance of the Goods or (if no advice has
been given) good trade practice; or if the Customer alters or repairs such Goods without the written consent of
Pico Technology.
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